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Reproduction of this manual in whole or in part without a written permission of  
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Trademarks 
Unigraf, UCD, UCD Console and TSI are trademarks of Unigraf Oy. 

DisplayPort™ and the DisplayPort™ logo are trademarks owned by the  

Video Electronics Standards Association (VESA®) in the United States and other countries. 

The Adopted Trademarks HDMI, High-Definition Multimedia Interface, the HDMI Logo and 

HDMI Port Logo are trademarks or registered trademarks of HDMI Licensing Administrator, 

Inc. in the United States and other countries 

HDCP is a trademark of Digital Content Protection LLC. 

Windows® 10, Windows® 8, Windows® 7 and Windows® XP are trademarks of  

Microsoft Corporation. 

All other trademarks are properties of their respective owners. 

Limited Warranty 
Unigraf warrants its hardware products to be free from defects in workmanship and materials, 

under normal use and service, for twelve (12) months from the date of purchase from Unigraf 

or its authorized dealer. 

If the product proves defective within the warranty period, Unigraf will provide repair or 

replacement of the product. Unigraf shall have the whole discretion whether to repair or 

replace, and replacement product may be new or reconditioned. Replacement product shall be 

of equivalent or better specifications, relative to the defective product, but need not to be 

identical. Any product or part repaired by Unigraf pursuant to this warranty shall have a 

warranty period of not less than 90 days, from the date of such repair, irrespective of any 

earlier expiration of original warranty period. When Unigraf provides replacement, then the 

defective product becomes the property of Unigraf. 

Warranty service may be obtained by contacting Unigraf within the warranty period. Unigraf 

will provide instructions for returning the defective product. 

CE Mark 
UCD-300 products meet the essential health and safety requirements, is in conformity with and 

the CE marking has been applied according to the relevant EU Directives using the relevant 

section of the corresponding standards and other normative documents. 
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 ABOUT THIS MANUAL 

Purpose 
This guide is the User Manual of UCD-300, USB-connected video capture units for use in a PC 

with Windows® 10 Windows® 8 or Windows® 7 operating system. 

The purpose of this guide is to 

• Provide an overview of the product and its features. 

• Provide instruction for the user on how to install the software and the drivers. 

• Introduce the HW features of the UCD-300 units. 

• Provide instructions for the user how to use UCD Console software. 

Product and Driver Version 
This manual explains features found in UCD Console Software Package 1.11. Please consult 

Unigraf for differences or upgrades of previous versions.  

Please consult the Release Notes document in the installation package for details of the SW 

and FW versions and changes to previous releases. 

Notes 
On certain sections of the manual, when important information or notification is given, text is 

formatted as follows. Please read these notes carefully. 

Note: This text is an important note 
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 INTRODUCTION 

Product Description 
UCD-300 family consists of two high speed, USB 3.0 connected video capture units UCD-323 

HDDP Dual and UCD-301 Digital. The UCD Console is the common graphical user interface 

(GUI) for all UCD-300 family units. UCD Console provides access to all functions of the unit.  

UCD-300 units feature a high-level Software Development Kit (SDK) for use in automated 

testing. It is called Test Software Interface (TSI). TSI allows for an easy integration of the 

Production and R&D testing routines into an automated test system environment. Please refer 

to TSI documentation for more details. 

Product Features 
• High resolution video and audio capture up to 4K / UHD 60 Hz 

• Support for multiple display interfaces including HDMI 2.0 and DP 1.2 

• Compatible with HDCP versions 1.3/1.4 and 2.2/2.3 

• 2 GB on-board high speed video buffer 

• High speed USB 3.0 host PC interface 

Please refer to Product Specifications in the appendix of this document for details. 

 

Functional Description 
UCD-300 units consist of a multimedia signal input stage, a control stage with on-board frame 

buffer, an internal pattern generator (in some models) and a PC interface stage. In the Input 

Stage the signal is conditioned and converted to desired format. The Interface and Control 

stages are either passing the captured data directly to the USB interface or storing it to the 

frame buffer. The internal pattern generator is able to source a signal for testing sink and 

branch units. The Interface & Control stages are receiving instructions from the host PC to 

configure and control the functionality of the unit. 

Please find below logical diagram of UCD-323 HDDP Dual 
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UCD-323 HDDP Dual 
The image below describes the connections in UCD-323 HDDP Dual  

Name Description 

DP in DisplayPort™ 1.2 compliant input from the upstream Source 

DP out DisplayPort™ 1.2 compliant output to the downstream Sink 

HDMI in HDMI 2.0 compliant input from the upstream Source 

HDMI out HDMI 2.0 compliant output to the downstream Sink 

Power in +12 Vdc Power Supply Input 

USB USB 3.0 connection to the host PC 

 

Note Capturing and sourcing high resolution video modes, especially 4K video modes set 

stringent requirements on the video cables and connectors. Unigraf has ensured the 

capabilities of the cables that are delivered with the UCD-323 HDDP Dual unit. Please 

contact Unigraf for assistance and details about evaluated cables. 

 

Warning In order to avoid damage to the unit and the PC, please always attach the power cord 

(Power In) to the unit first, and after that connect the USB cable to your PC. 
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UCD-301 Digital 
The image below describes the connections in UCD-301 Digital  

Name Description 

DP In DisplayPort 1.2 compliant input from the upstream Source 

HDMI In HDMI 2.0 compliant input from the upstream Source 

S/PDIF In Optical digital audio input 

Power In +12 Vdc Power Supply Input 

USB USB 3.0 connection to the host PC 

 

Note Capturing and sourcing high resolution video modes, especially 4K video modes set 

stringent requirements on the video cables and connectors. Unigraf has ensured the 

capabilities of the cables that are delivered with the UCD-301 Digital unit. Please 

contact Unigraf for assistance and details about evaluated cables. 

 

Warning In order to avoid damage to the unit and the PC, please always attach the power cord 

(Power In) to the unit first, and after that connect the USB cable to your PC. 
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 INSTALLATION 

Unpacking 
The UCD-300 product shipment contains: 

• The UCD-323 or UCD-301unit 

• AC/DC Power supply (100 to 240 Vac 50/60 Hz input, +12 Vdc output)  

• USB 3.0 compliant cable  

Installation Package 
The UCD-300 software installation package can be obtained from Unigraf download page at 

https://www.unigraf.fi/downloads/  

The installation package is a bundle between the components needed for UCD Console and for 

TSI SDK. The bundle contains the following items: 

• Windows drivers (installed during set up)  

• UCD Console software GUI (installed during set up) 

• License Manager (installed during set up) 

• UCD Configuration Utility (installed during set up) 

• TSI SDK 

• User Manuals including this document. 

In some cases, you will need to also update the firmware of the unit. If in doubt, please contact 

Unigraf. 

Note: The software should be installed before connecting the UCD-300 unit in your PC. 

 

Note: System administrator's privileges are required for performing the installation. 

Software Installation 
 Start the installation by running Unigraf Software Bundle Setup.exe 

Once the installer has started, a welcome page is displayed. The welcome page shows the 

software package release version. 

 Click Next to continue. In the next dialogs, you will be able to define the software components 

installed. 

The next two dialogs will allow you to define the installation folder in your PC and the Start 

Menu folder used.  

 When you are ready with the selections, click Install to start the installation. 

 Click Finish to exit the installation dialog. 

https://www.unigraf.fi/downloads/
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 FIRMWARE UPDATE 

UCD Configuration Utility is used to load an updated firmware to the device. As an option, 

UCD Configuration Utility enables the user to select the operation roles present in the UCD-

300 unit. The utility configures a firmware set for the selected operation roles and programs the 

firmware set to the device. Please contact Unigraf for details. 

Note: Firmware update is a sensitive process. Please do not disconnect the device from the PC 

and do not power it off before the operation is completed unless specially requested. 

Avoid plugging and unplugging other USB devices when the firmware update is in 

progress. 

To update the firmware or create a new configuration on a UCD-300 device, please perform 

the following steps: 

 Connect the UCD-300 unit to a power supply and connect the USB cable. 

 Open UCD Console. Select Tools > Firmware update. 

You can launch the utility alternatively by running the UCD Firmware Configuration in Start 

Menu > Unigraf. 

The first page of the utility indicates the firmware component versions present in the package. 

Please click Next. 

 From the list of connected UCD-300 devices please select the one that you want to update. 

Click Next.  
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Updated Modules 
The tool prompts you for selection of the firmware modules to be updated. It compares the 

modules in the selected device and omits the ones that are the same. 

 When you are done, click Next. 

While the configuration is in progress you will be asked to power cycle (Power OFF > Wait 

for 10 sec > Power On) the device between some parts. 

Note:  The procedure may take several minutes depending on the speed of the USB connection 

of the host PC. 

 When completed, power cycle the device. 

Note: The new firmware will be taken in use only when the device is powered up next time. 
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Change Device Configuration 
UCD-300 devices can feature four simultaneous interface Roles (please refer to  

UCD Console > Select Role below). Changing the role configuration is done by selecting the 

firmware packages loaded to the UCD-300 device. For selecting you need to open  

UCD Firmware Configuration utility in a special mode. The easiest way is to create a batch 

file with Notepad (e.g. config.bat) with the following content:  

 ucdconfig config 

In the special mode, you will be able to initiate the configuration dialogs. For that, select 

Change device configuration check box. 

In the third dialog UCD Device Roles select the four roles that you prefer to be available in 

UCD Console. 

After selection, please click Next to proceed to firmware update as described above. 
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 LICENSE MANAGER 

Licensing 
The features of UCD Console GUI are divided into groups based on the target use of the 

device. Some basic features can be used without licenses. Advanced feature groups have their 

dedicated licenses that open the related part of the GUI or enable the related control. 

Unigraf licenses are provided as strings of characters, License Keys. Each License Key 

enables a dedicated function in one device. Each device has its dedicated Seed Number. Each 

License Key is tied to one Seed Number. License Keys can be freely used in any number of 

PCs 

License keys are managed with Unigraf License Manager. By default, shortcut to Unigraf 

License Manager can be found in Start Menu under: All programs/Unigraf/TSI. 

Please click Yes in the first dialog. License Manager can be run only with Administrator rights. 

Note: System administrator's privileges are required for accessing the licenses. 

License Manager GUI 
Once the application starts up, it will look for any licensing enabled Unigraf device. If no 

suitable device families are detected, License Manager will exit. Please first select one of the 

available device families by clicking one of the device family selector buttons. 

In the list of Attached Devices please select the device in question. You can find the serial 

number and the seed number of your device in a sticker attached to the bottom of your device. 

The Back button will bring you back to the device family selection screen. The Refresh button 

will re-scan the system for installed hardware. 
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Managing Licenses 

Seed Number 

Each license is tied to a hardware unit with the help of the Seed Number. Each unit has a 

unique Seed Number. You can find the Seed Number of the selected unit in the top of the 

dialog. 

The Seed Number link in the dialog will allow you to copy & paste the Seed Number of the 

selected device for e.g. ordering Licenses. 

Adding New License Keys 

To add a new license key for a device, please enter the characters from the license sticker to the 

boxes provided. The License Manager will automatically move the caret across the edit boxes 

as you type. If you have the key in text format, copy it and paste to the leftmost box. 

Once the license key is fully entered, click the Install. The license is authenticated and if it is 

valid, the license will appear in the list of installed licenses. If the key fails to authenticate, an 

error message is displayed. If this happens, please make sure that you have typed the key 

correctly and that the seed number on the license key sticker matches the seed number 

displayed seed number for the device. 

Please note that to avoid confusion, some letters will never appear in a license key because 

they resemble numbers: For example, capital 'G' and number '6' are very similar when printed 

with small font. When in doubt, use numbers. 

Also, please notice, that characters that can't be part of valid license key are not accepted as 

input. When appropriate an automatic conversion is applied while typing: For example, lower 

case letters are converted to upper case automatically. 

Managing Installed Licenses 

The Installed licenses list shows all currently installed licenses for the currently selected 

device. The list shows the actual license key, and what that key unlocks. 

Remove Selected will uninstall selected licenses. To uninstall a license, click on the license 

and then click the Remove Selected button. 

Export will allow you to save all installed licenses for the currently selected device into an INI 

file for backup and distribution to other PCs. Please notice that licenses from multiple devices 

can be exported into the same INI file. 

Import will install licenses from an INI file for the currently selected device. 
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 UCD CONSOLE 

UCD Console is the graphical user interface (GUI) of UCD-300 family for desktop use. It 

provides the user access to all features of the unit. UCD Console also includes powerful 

debugging and analysis tools enabling the user to monitor the status of the display interfaces 

and assist in the problem detection.  

The various features of the UCD-300 are divided into interface specific screens and tabs. Each 

tab contains data and controls for a specific feature.  

Device Selection 
You can find the shortcut of UCD Console by default under Start Menu path 

All programs/Unigraf/UCD-300. Once UCD Console GUI is launched the dialog provides a 

list of UCD-300 devices connected in the PC. Please select your target device by clicking on 

the appropriate button. If you cannot find your device in the list, please confirm the power and 

USB connection to the device and click the Rescan … button. 
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Select Role 
The use of UCD-300 devices with UCD Console is divided in display interface specific roles. 

The structure of UCD Console varies between roles by having a varying set of tabs dedicated 

to functionalities available in the enabled role. The table below lists the roles and tabs available 

in each role. Please find a detailed description of each role in the later chapters of this manual. 

Each UCD-300 model features a unique set of modes available. In special occasions, Unigraf 

can create custom configurations. Please contact Unigraf Support for details.  

Available Mode Configurations for UCD-301 
In addition to the separate HDCP 2.3 enabled HDMI and DP Reference Sink roles, in UCD-

301 you can select a combined mode where three roles are available in one configuration. 

 

Role Tabs available 

HDMI Reference Sink (HDCP 2.3) Video preview and saving (Video). 
Audio monitoring and saving (Audio).  
Status information and control of the upstream link (Link). 
EDID editor (EDID). 
HDCP 1.4 and 2.3 status monitor and control (HDCP). 
Monitor InfoFrame data (InfoFrames). 
Executing TSI Test cases (Source DUT Testing). 

DisplayPort Reference Sink (HDCP 2.3) Video preview and saving (Video). 
Audio monitoring and saving (Audio). 
Status information and control of the upstream link (Link). 
EDID editor (EDID). 
DPCD editor (DPCD). 
HDCP 1.3 and 2.3 status monitor and control (HDCP). 
Monitor Secondary-Data Packets (SDP) 
Event log (Event log) 
Executing TSI Test cases (Source DUT Testing). 
Executing HDCP 2.3 CTS Tests (Source DUT Testing). 

C
om

bi
ne

d 
M

od
e 

HDMI Reference Sink Video preview and saving (Video). 
Audio monitoring and saving (Audio).  
Status information and control of the upstream link (Link). 
EDID editor (EDID). 
HDCP 1.4 status monitor and control (HDCP). 
Read InfoFrame data (InfoFrames). 
Executing TSI Test cases (Source DUT Testing). 

DisplayPort Reference Sink Video preview and saving (Video). 
Audio monitoring and saving (Audio). 
Status information and control of the upstream link (Link). 
EDID editor (EDID). 
DPCD editor (DPCD). 
HDCP 1.3 status monitor and control (HDCP). 
Executing TSI Test cases (Source DUT Testing). 

SPDIF Reference Sink Audio monitoring and saving (Audio). 
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Available Mode Configurations for UCD-323 

Role Tabs available 

HDMI Reference Sink  
(HDCP 2.3) 

Video preview and saving (Video). 
Audio monitoring and saving (Audio).  
Status information and control of the upstream link (Link). 
EDID editor (EDID). 
HDCP 1.4 and 2.3 status monitor and control (HDCP). 
Monitor InfoFrame data (InfoFrames). 
Executing TSI Test cases (Source DUT Testing). 

DisplayPort Reference Sink 
(HDCP 2.3) 

Video preview and saving (Video). 
Audio monitoring and saving (Audio). 
Status information and control of the upstream link (Link). 
EDID editor (EDID). 
DPCD editor (DPCD). 
HDCP 1.3 and 2.3 status monitor and control (HDCP). 
Monitor Secondary-Data Packets (SDP) 
Event log (Event log) 
Executing TSI Test cases (Source DUT Testing). 
Executing HDCP 2.3 CTS Tests (Source DUT Testing). 

HDMI Reference Source  
(HDCP 2.3) 

Video pattern generator (Pattern Generator). 
Status information and control of the downstream link (Link). 
EDID editor (EDID). 
HDCP status monitor and control (HDCP). 

DisplayPort Reference Source  
(MST – 2 streams, HDCP 2.3) 

Video pattern generator 2 stream MST (Pattern Generator). 
Status information and control of the downstream link (Link). 
EDID editor (EDID). 
DPCD monitor (DPCD) 
HDCP status monitor and control (HDCP). 

DisplayPort Reference Source  

(SST, HDCP 2.3) 

Video pattern generator with custom patterns and SST  
(Pattern Generator). 
Status information and control of the downstream link (Link). 
EDID editor (EDID). 
DPCD monitor (DPCD) 
HDCP status monitor and control (HDCP). 
Executing HDCP 2.3 CTS Tests (Sink DUT Testing). 

 

A full description of the functions and the licensing can be found in Appendix B Licensing. 
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Options 
Options can be found in Tools > Options. 

Video Audio and Misc. Options 

Image File Format 

You can save the captured frames either in PPM, BMP or JPG bitmap file format. In PPM 

format the files are stored with the captured color depth, with other formats the color depth is 

truncated to 8 bits per color. 

Audio File Format 

Audio files are stored in WAV format 

Audio Buffer size 

You can define how much memory is allocated in the PC for captured audio. Increased buffer 

size will ensure a smooth audio output but will also increase the delay between the capture of 

the audio stream and its playback. 

Folders 

Please select the directories in the PC for saving the captured images and audio and the saved 

Presets. DSC Related presets can be omitted with UCD-323 and UCD-301. 

DSC 

Omitted when using UCD-323 or UCD-301 

Misc. options 

Apply color conversions to saved images: When saving captured frames, the Color Mode 

selected in Video tab will be applied also to saved images. 

Bypass 4:2:x –> 4:4:4 conversions: 4:2:2 and 4:2:0 images are previewed and stored as 

received, without pixel doubling. 
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HDCP protected monitor: Text appearing if the monitor where UCD Console is viewed is 

HDCP compliant and HDCP is enabled. This feature enables preview of captured HDCP 

encrypted content in Video tab. 

TSI Integration 

Selections for generating a workspace for TSI usage. 

Enable TSI Integration: When selected, TSI Integration tool (Tools > TSI Integration) is 

enabled. When exporting test parameters in Sink / Source DUT Testing, test code is also 

appended for execution with TSI. 

Please refer to TSI Integration and Exporting Tests for TSI later in this document. 

 

AUX Analyzer Options 
Options for configuring the way data is presented in AUX Analyzer tab in Event Log.  

Please find full description of the controls in chapter Event Log / DP AUX Analyzer later in 

this document. 

TSI Integration 
Tools > TSI Integration. Selections for generating a workspace for TSI usage. 

TSI Integration enables automatic creation of the necessary configuration files for executing 

tests exported from UCD Console’s Sink DUT testing or Source DUT Testing. 

Please refer to chapters Source DUT Testing Tab and Sink DUT Testing Tab later in this 

document for description about exporting tests. 
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Detaching Tabs 
You can detach most of the UCD Console tabs into a separate window for being able to 

monitor and control separate features simultaneously. To detach a tab Right-click on a tab and 

select Detach Page. To glue the tab back to the main window, click on the red Close button in 

the top right hand corner of the window or press <Alt> + F4 on your keyboard. 
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 HDMI REFERENCE SINK 

HDMI Reference Sink function is available in UCD-323 HDDP Dual and UCD-301 Digital. In 

HDMI Reference Sink role, the device is using one input channel, HDMI Sink (HDMI RX). 

The corresponding vertical tab can be seen on the left edge of the GUI.  

The horizontal tabs on the top of the GUI enable the various functions available for the input 

channel. HDMI RX features the following tabs. Some of the tabs are enabled by default, some 

only when an applicable license is included.  

• Video preview and saving (Video). Enabled by default. 

• Audio monitoring and saving (Audio). Enabled by default. 

• Status information and control of the upstream link (Link). Enabled by default. 

• EDID editor (EDID). 

• HDCP status monitor and control (HDCP). 

• Read InfoFrame data (InfoFrames). 

• Executing TSI Test cases (Source DUT Testing). 
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Video Tab 
Video tab is the Preview window for the captured HDMI stream. 

Input video mode 

The measured input resolution, frame rate and color format is shown below the preview 

window. The indication of the number of frames captured to the PC shows you the pace of the 

image data transfer to the PC. 

 

Disable / Enable Preview 

Click the button to start or stop capturing video frames. 

Color Mode for preview 

 

• No Conversion: The captured color components are interpreted as R, G and B 

respectively. No color conversion will be done. 

• Automatic: The color mode is selected based on the information in the MSA. If there is 

no color information available, “No Conversion” is used. 

• YCbCr (ITU-709) - > RGB: The captured data components are interpreted as Y, Cb, and 

Cr respectively. Color conversion to RGB is done based on ITU-709 standard. 

• SMPTE 170M - > RGB: The captured data components are interpreted as Y, U, and V 

respectively. Color conversion to RGB is done based on SMPTE 170M standard. 

Note: Please note that the color mode selection applies to the preview window only. All 

internal functions use the raw image data as captured from the input channel. 
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Save one frame 

 

Capture and save one video frame as a bitmap file in the PC. The format and storage location 

can be selected in Tools > Options pull-down menu. The available bitmap formats are PPM, 

BMP and JPG. 

The selections in Tools > Options menu define if the frame bitmap will be stored as captured 

from the display interface or if the color mode conversion selected for preview will be applied. 

Note Please note that when HDCP is enabled, i.e. when HDCP protected content is received, 

no content can be saved. 

Sequence recording 

 

Clicking the button opens a dialog for definition of number of frames recorded. Buffered mode 

can also be enabled in this dialog. 

In buffered mode, all input frames are captured non-drop until the on-board frame buffer will 

be full. The dialog also informs the capacity of the buffer with the selected video mode. 

In non-buffered mode, only one input frame is buffered at a time. Frames will be skipped if the 

transfer of the data to the PC is slower than the input data rate. 

Note: Please note that buffered mode cannot be used when Audio preview is enabled. 

 

Note Please note that when HDCP is enabled, i.e. when HDCP protected content is received, 

no content can be saved. 
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Snap preview 

 

When clicked, one frame of the incoming video is captured and shown in a new Snapshot tab. 

The captured bitmap can be saved with Save one frame function described above. 

Color Information of the Captured Bitmap can be evaluated by placing the mouse cursor on 

top of the preview image. The lower right-hand side ribbon of the GUI lists 

• Location of the cross cursor on the bitmap 

• The intensity of the Red, Green and Blue components of the pixel on the cursor location 

• The HTML HEX color code of the pixel on cursor location 

Zoom of the Preview Image can be altered by right clicking on top of the preview image and 

selecting between 

• Fit Window 

• Zoom 25% 

• Zoom 50% 

• Zoom 100% 

• Zoom 200% 

• Zoom 500% 

While in the Snap preview mode clicking on the “Camera” icon will take additional snapshots 
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Audio Tab 
Audio tab is enabled by default. Audio tab has a preview of the audio signal format and the 

controls for audio playback and recording. 

The audio signal format is shown in two ways 

• The ‘oscilloscope’ panel displays the waveforms of the received audio channels.  

• The frequency spectrum of the audio is shown in the lower panel. The range of the 

spectrum display is from 0 to 1/2 of the input sampling rate. The amplitude scale of the 

spectrum display can be selected between ‘Linear’ to 80 dB. 

The span of the preview window is defined with Audio preview size found in Tools > Options 

dialog. The value is given in ksamples (1024 samples). The relation between the preview 

window span in milliseconds (msec) and the value given in Audio preview size depends on the 

sampling frequency. Please do not exceed the Audio buffer size set in the same dialog. 

Disable / Enable Preview 

Use this button to control capturing the audio data. 
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Playback device selection 

You can enable audio playback in your PC by selecting the Playback check-box. Use the 

combo-box to select the audio device in the host PC through which the captured audio is 

played. By default, the Default Audio device of your PC is chosen. Please Disable Preview to 

make changes. 

Note Please note that the audio capabilities of the audio playback device of your PC are not 

automatically reflected in the audio capabilities description in UCD-300 EDID. Since 

UCD-300 is not performing any audio format conversion, it might occur that the source 

provides an audio format that the selected playback device is not supporting. In case a 

conflict occurs, please change manually the EDID content or disable audio playback to 

monitor the waveforms in UCD Console. 

Refresh audio device list 

 

Click here to re-read the list of audio devices after making changes to the host PC 

configuration. 

Audio Buffer Size 

You can define the amount of buffering used in the data transfer between the UCD-300 unit 

and the PC. Audio buffer size can be found in Tools > Options dialog. Increased buffer size 

will ensure a smooth audio output but will also increase the delay between the capture of the 

audio stream and its playback. 

Start audio recording 

 

Clicking the button, you can start or stop recording the captured audio in the PC using 

WAVeform audio format (*.wav) format. In the pop-up dialog, you can define the recording 

duration. The folder where the audio file will be saved can be selected in File > Options. 

Input audio mode 

 

This field (in the bottom of the dialog) indicates detected audio mode in the input stream. 
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Link Tab 
Link tab is enabled by default. 

Link tab contains four panels: HPD, Link Status, Timing and Audio Return Channel.  

HPD 

Status of the Hot Plug Detect (HPD) signal. Click Assert to permanently set the HPD signal to 

logical “High” state. Click Deassert to permanently set the HPD signal to logical “Low” state 

(de-activate). 

Link status 

This panel contains three indicators: 

• The TMDS Bit Clock Ratio detected 

• Input Stream Lock indicator 

• Status of the three TMDS data channels 

Timing 

Measured timing information, frame rate and color format details are shown in this panel. 

CRC 

This panel contains the CRC (Cyclic redundancy check) calculated of all the red, green and 

blue sub-pixels correspondingly. Click Update to re-read. 

Audio Return Channel (ARC) (UCD-301 only) 

Select Enable to enable ARC function.  

You can select the ARC audio Source to be either  

• Loopback of captured HDMI audio, or 

• Audio received in the S/PDIF input 

Select one of the ARC modes via the Mode radio buttons 

• Single mode (Utility line only) 

• Common Mode (Utility and HPD line). 

The Timing, CRC and ARC panels are enabled with UCD Pro for HDMI Sink license. 
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EDID Tab 
EDID Tab is enabled with UCD Pro for HDMI Sink license. 

This tab provides tools for accessing the EDID of the UCD-300 Sink presented to the 

Upstream Source Device. There are three basic functions: 

• Load and save EDID data files in the host PC 

• Edit the EDID contents 

• Program and read the contents of the hardware EDID memory 

EDID Files 

With Load… and Save as… you can read and write a hex EDID file from your PC. Please 

note that the program does not alter the contents of the EDID file or verify its integrity during 

load and save operation. 

Note Four blocks (512 bytes) of EDID code is read. If the device is not supporting all four 

blocks, the non-supported area is replaced with zeroes. 

 Currently the EDID Editor does not support Display ID. You can however modify hex 

EDID files with the HEX Editor or load and program externally generated hex EDID 

files that have Display ID content. 

HEX Editor 

When EDID content is either loaded from a file or read from the hardware EDID memory, it is 

shown in the EDID Data panel on the left-hand side of the dialog. You can edit the EDID 

contents by typing over the existing values. The altered content is highlighted with RED. Please 

note that Hex Editor itself does not alter the contents of the EDID data or verify its integrity. 

Once you are done with editing the data, you can either save it to an *.ecd file in your PC with 

Save as… or program it to the hardware EDID memory with Write. 
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EDID Editor 

You can edit the EDID structures of the data in the HEX Editor by clicking EDID Editor. 

EDID Editor is launched in a separate pop-up window. Please see the description of the EDID 

editor in Chapter EDID Editor later in this document. 



 HDMI Reference Sink  

 31.  

HDCP Tab 
HDCP Tab is enabled with UCD Pro for HDMI Sink license. 

HDCP tab is the dialog for monitoring the HDCP (for High-Bandwith Digital Content 

Protection) status and controlling the HDCP capabilities of the connected UCD-300 device. 

Status 

The status field indicates the HDCP status of the connected UCD-300 device. 

• Active: The link between UCD-300 and the upstream source has been encrypted. 

• Authenticated: The HDCP handshake between the UCD-300 and the upstream source has 

been completed successfully. 

• Declared as HDCP capable: The UCD-300 unit recognizes HDCP handshake messages. 

• Keys loaded: The HDCP keys are loaded to the UCD-300 unit. 

Configuration 

• HDCP Capable: Uncheck the box to disable HDCP. 

Keys 

You can select if you are using Production or Facsimile HDCP keys. To remove the keys, 

select None.  
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HDCP 1.4 vs. HDCP 2.3 

UCD-300 devices support by default HDCP 1.4 standard with HDMI. HDCP 2.3 support is 

enabled with HDCP 2.3 Support license 
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InfoFrame Tab 
InfoFrame Tab is enabled with UCD Pro for HDMI Sink license. 

InfoFrames tab displays in hexadecimal format the following received infoframes: 

• ACR (Audio Clock Regeneration) 

• ASP (Audio Sample Packet) 

• GCP (General Control Packet) 

• ACP (Audio Content Protection Packet) 

• ISRC1 (International Standard Recording Code) 

• ISRC2 (International Standard Recording Code) 

• OBA (One Bit Audio sample packet) 

• DTS (DTS Audio packet) 

• HBR (High Bitrate Audio stream packet) 

• GMP (Gamut Metadata packet) 

• 3D ASP (3D Audio Sample packet) 

• 3D OBA (3D One Bit Audio sample packet) 

• AMP (Audio Metadata Packet) 

• MST_ASP (Multi-stream audio sample packet) 

• MST_OBA (One Bit Multi-stream audio sample packet) 

• VSI (Vendor Specific InfoFrame) 

• AVI (Auxiliary Video Information) 

• SPD (Source Product Descriptor) 

• AIF (Audio InfoFrame) 

• MPEG (MPEG Source InfoFrame) 

• DRM (Dynamic Range and Mastering InfoFrame) 

Please click Update to re-read the InfoFrame data. 
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Source DUT Testing Tab 
Source DUT Testing Tab is enabled with UCD Pro for HDMI Sink license. 

Please refer to Appendix B later in this document for description of the tests available. Source 

DUT Testing enables testing of a HDMI Source DUT. Please refer to Appendix E of this 

document to get a full definition of the Test Cases and test parameters.  

Select the tests for execution by clicking the corresponding row. 

Clicking Configure… opens a dialog for defining the test parameters for that set. Please refer 

to Test Parameters below for description. 

Parameters from Test descriptor files can be loaded with Import and stored with Export. Please 

refer to chapter Exporting Tests for TSI later in this document. 

 Tests are started by clicking Run Selected. By clicking Abort the sequence is stopped. 

Test flow can be controlled with Repeats of the test sequence, Delay time between individual 

tests or Stop on Failure that stops the whole sequence if one of the tests fail. 

At the completion of each test the result of the test is indicated in the matrix on the right hand 

side of the test panel. For each test the matrix lists the number of occurrences of each result and 

the number of tries performed. 

Click Save Report to generate a HTML report file for sharing the results with other parties for 

viewing without UCD Console. 

By clicking Clear All the test log and the results matrix are cleared. 
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Test Parameters 

Each test set has its dedicated set of test parameters. Open a dialog for defining the parameters 

by clicking Configure…. 

Parameters of Electrical Test Group 

Each test in the Electrical test set uses parameters to control test execution and acceptance 

criteria. Parameters for all tests are collected in the dialog Electrical test parameters.  

Parameters of CRC Test Set 

CRC Video test parameters dialog allows you to define the test duration, number of frames 

captured, and errors allowed. It allows you to define the frame size and capture. 

Click Capture now to record Reference CRCs. Please define the number of frames used as 

reference – either one or the number of frames in the predefined test sequence.  

Presets 

In both dialogs you can save the selected parameters as Presets. Please click Presets… to save 

your configuration. If you have saved configuration Presets, you can load one of the saved 

ones, save a new Preset or delete a Preset. 
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Exporting Tests for TSI 
Unigraf UCD Console includes a feature rich Software Development Kit (SDK) for use in 

automated testing. The SDK is called Test Software Interface (TSI). TSI allows for an easy 

integration of Production and R&D testing routines into an automated test system environment. 

Please refer to TSI documentation found in additional Unigraf manuals for details. 

The tests included in UCD Console’s Source DUT Testing tab and Sink DUT Testing tab can 

be executed in TSI environment. A straightforward way is to use UCD Console’s Tools > 

TSI Integration dialog to create the necessary files for TSI environment and use Export 

function in DUT Testing tabs to include the intended tests. 

Export: Save parameters of the selected test to a file. If TSI Integration is enabled in  

Tools > Options, also the test is appended into ‘Run Test’ file in TSI workspace folder. 

Import: Recall parameters from configuration file. If TSI Integration is enabled in Tools > 

Options, parameters are imported from a file in TSI workspace folder 
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 DISPLAYPORT REFERENCE SINK 

DisplayPort Reference Sink function is available in UCD-323 HDDP Dual and 

UCD-301 Digital. In DisplayPort Reference Sink role, the device is using one input channel, 

DisplayPort Sink (DPRX). The corresponding vertical tab can be seen on the left edge of the 

GUI.  

The horizontal tabs on the top of the GUI enable the various functions available for the input 

channel. Some of the tabs are enabled by default, some only when an applicable license is 

included. DPRX features the following functions. 

• Video preview and saving (Video). Enabled by default. 

• Audio monitoring and saving (Audio). Enabled by default. 

• Status information and control of the upstream link (Link). Partly enabled by default. 

• EDID editor (EDID). 

• DPCD editor (DPCD). 

• HDCP status monitor and control (HDCP). 

Video Tab 
Video tab is the Preview window for the captured DisplayPort stream. 

Input video mode 

 

The measured input resolution, frame rate and color format is shown below the preview 

window. The indication of the number of frames captured to the PC shows you the pace of the 

image data transfer to the PC. 

Disable / Enable Preview 

Click here the button to start or stop capturing video frames. 
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The top ribbon of the tab has the following controls: 

Color Mode for preview 

 

• No Conversion: The captured color components are interpreted as R, G and B 

respectively. No color conversion will be done. 

• Automatic: The color mode is selected based on the information in the MSA. If there is 

no color information available, “No Conversion” is used. 

• YCbCr (ITU-709) - > RGB: The captured data components are interpreted as Y, Cb, and 

Cr respectively. Color conversion to RGB is done based on ITU-709 standard. 

• SMPTE 170M - > RGB: The captured data components are interpreted as Y, U, and V 

respectively. Color conversion to RGB is done based on SMPTE 170M standard. 

Note: Please note that the color mode selection applies to the preview window only. All 

internal functions use the raw image data as captured from the input channel. 

Save one frame 

 

Capture and save one video frame as a bitmap file in the PC. The format and storage location 

can be selected in Tools > Options pull-down menu. The available bitmap formats are PPM, 

BMP and JPG. 

The selections in Tools > Options menu define if the frame bitmap will be stored as captured 

from the display interface or if the color mode conversion selected for preview will be applied. 

Note Please note that when HDCP is enabled, i.e. when HDCP protected content is received, 

no content can be saved. 

Sequence recording 

 

Clicking the button opens a dialog for definition of number of frames recorded. Buffered mode 

can also be enabled in this dialog. 

In buffered mode, all input frames are captured non-drop until the on-board frame buffer will 

be full. The dialog also informs the capacity of the buffer with the selected video mode. 

In non-buffered mode, only one input frame is buffered at a time. Frames will be skipped if the 

transfer of the data to the PC is slower than the input data rate. 

Note: Please note that buffered mode cannot be used when Audio preview is enabled. 

 

Note Please note that when HDCP is enabled, i.e. when HDCP protected content is received, 

no content can be saved. 
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Snap preview 

 

When clicked, one frame of the incoming video is captured and shown in a new Snapshot tab. 

The captured bitmap can be saved with Save one frame function described above. 

Color Information of the Captured Bitmap can be evaluated by placing the mouse cursor on 

top of the preview image. The lower right-hand side ribbon of the GUI lists 

• Location of the cross cursor on the bitmap 

• The intensity of the Red, Green and Blue components of the pixel on the cursor location 

• The HTML HEX color code of the pixel on cursor location 

Zoom of the Preview Image can be altered by right clicking on top of the preview image and 

selecting between 

• Fit Window 

• Zoom 25% 

• Zoom 50% 

• Zoom 100% 

• Zoom 200% 

• Zoom 500% 

While in the Snap preview mode clicking on the “Camera” icon will take additional snapshots 
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Audio Tab 
Audio tab is enabled by default. Audio tab has a preview of the audio signal format and the 

controls for audio playback and recording. 

The audio signal format is shown in three ways 

• The ‘oscilloscope’ panel displays the waveforms of the received audio channels.  

• The frequency spectrum of the audio is shown in the lower panel. The range of the 

spectrum display is from 0 to 1/2 of the input sampling rate. The amplitude scale of the 

spectrum display can be selected between ‘Linear’ to 80 dB. 

The span of the preview window is defined with Audio preview size found in Tools > Options 

dialog. The value is given in ksamples (1024 samples). The relation between the preview 

window span in milliseconds (msec) and the value given in Audio preview size depends on the 

sampling frequency. Please do not exceed the Audio buffer size set in the same dialog. 

Disable / Enable Preview 

Use this button to control capturing the audio data. 
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Playback device selection 

You can enable audio playback in your PC by selecting the Playback check-box. Use the 

combo-box to select the audio device in the host PC through which the captured audio is 

played. By default, the Default Audio device of your PC is chosen. Please Disable Preview in 

order to make changes. 

Note Please note that the audio capabilities of the audio playback device of your PC are not 

automatically reflected in the audio capabilities description in UCD-300 EDID. Since 

UCD-300 is not performing any audio format conversion, it might occur that the source 

provides an audio format that the selected playback device is not supporting. In case a 

conflict occurs, please change manually the EDID content or disable audio playback to 

monitor the waveforms in UCD Console. 

Refresh audio device list 

 

Click here to re-read the list of audio devices after making changes to the host PC 

configuration. 

Audio Buffer Size 

You can define the amount of buffering used in the data transfer between the UCD-300 unit 

and the PC. Audio buffer size can be found in Tools > Options dialog. Increased buffer size 

will ensure a smooth audio output but will also increase the delay between the capture of the 

audio stream and its playback. 

Start audio recording 

 

Clicking the button, you can start or stop recording the captured audio in the PC using 

Waveform Audio File Format, WAV (*.wav) format. In the pop-up dialog, you can define the 

recording duration. The folder where the audio file will be saved can be selected in Tools > 

Options. 

Input audio mode 

 

This field (in the bottom of the dialog) indicates detected audio mode in the input stream. 
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Link Tab 
Link tab is partly enabled by default, partly with license: UCD Pro for DP Sink. 

Link tab contains four panels: Cable / HPD, Link Status, Link Configuration and Stream 

Status. 

Cable / HPD 

Indicator lights of the state of the cable. Cable indicates that the hardware has detected an 

upstream cable. HPD indicates that the HPD signal is logical “high”. 

Clicking the Deassert button will cause HPD line to be set to logical “low” (de-asserted) and 

hence no HPD pulse can be generated. Click the Assert to re-activate the HPD line (set to 

logical “high”). 

To apply a HPD Pulse with programmable duration click Pulse HPD. The duration will be 

defined in the provided field. 

For applying a short pulse click Short Pulse. Pulse duration is 1 msec. 

Link Status 

Link Status displays the status of the link training and the link parameters negotiated between 

UCD-300 Sink and the Upstream Source. The data is retrieved from the DPCD registers of the 

UCD-300 Sink. The status is updated automatically.  
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Link Configuration 

Link configuration is enabled with UCD Pro for DP Sink license. 

Cable / HPD 

Indicator lights of the state of the cable. Cable indicates that the hardware has detected an 

upstream cable. HPD indicates that the HPD signal is Asserted (logical “high”). 

Clicking the Deassert button will cause HPD line to be set to logical “low” (de-asserted) and 

hence no HPD pulse can be generated. Click the Assert to re-activate the HPD line (set to 

logical “high”). 

To apply an HPD Pulse with programmable duration click Pulse HPD. The duration will be 

defined in the provided field. 

For applying a short pulse click Short Pulse. Pulse duration is 1 ms. 

Link Configuration 

Link Configuration allows the user to change the way the Sink capabilities are announced in 

the DPCD registers of the UCD-300 Sink. Maximum Lane Count and Maximum Link Rate are 

set with their appropriate radio buttons. To update the new status to the DPCD registers click 

Apply. 

Other Capabilities section includes controls of features like TPS3 and TPS4 

Scrambler Reset; Selection of the value to which the Linear Feedback Shift Register (LFSR) 

is reset during scrambler reset. 

Click Enable Fast LT to enable support for a link training without AUX transactions. 

When Force cable status to plugged is checked, sink functionality is active regardless of a 

failure of upstream device detection e.g. due to incorrect AUX Channel electrical termination. 

DP_PWR (+3.3V) Enable +3.3 Vdc in pin 20 of DP connector (Available depends on 

hardware version. Please contact Unigraf if in doubt.). 

To apply a Hot-Plug Detect pulse automatically after updating the status, select Generate 

HPD pulse on Apply. HPD pulse duration will be defined in the Pulse HPD field. 
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Stream Status 

Stream status is enabled with UCD Pro for DP Sink license. 

Video Timing Details are retrieved from the Main-Stream Attributes (MSA) of the monitored 

stream. Frame rate is measured by UCD-300 Local Sink.  

Note: Please note that the MSA information used for Video Timing Details is provided by the 

Upstream Source, it is not measured by the UCD-300 Local Sink. 

CRC 

The 16-bit CRC (checksum, cyclic redundancy check) values of the three color components 

calculated by the Sink hardware. To re-calculate, click Update Link Status. 

The 16-bit DSC CRC values of the captured DSC compressed frame. “Value 0” is calculated 

from 1st, 4th, 7th … byte, “Value 1” from 2nd, 5th, 8th … byte and “Value 2” from 3rd, 6th, 9th … 

byte. 
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EDID Tab 
EDID Tab is enabled with UCD Pro for DP Sink license. 

This tab provides tools for accessing the EDID of the UCD-300 Sink presented to the 

Upstream Source Device. There are three basic functions: 

• Load and save EDID data files in the host PC 

• Edit the EDID contents 

• Program and read the contents of the hardware EDID memory 

EDID Files 

With Load… and Save as… you can read and write a hex EDID file from your PC. Please 

note that the program does not alter the contents of the EDID file or verify its integrity during 

load and save operation. 

Note Four blocks (512 bytes) of EDID code is read. If the device is not supporting all four 

blocks, the non-supported area is replaced with zeroes. 

 Currently the EDID Editor does not support Display ID. You can however modify hex 

EDID files with the HEX Editor or load and program externally generated hex EDID 

files that have Display ID content. 

HEX Editor 

When EDID content is either loaded from a file or read from the hardware EDID memory, it is 

shown in the EDID Data panel on the left hand side of the dialog. You can edit the EDID 

contents by typing over the existing values. The altered content is highlighted with RED. Please 

note that Hex Editor itself does not alter the contents of the EDID data or verify its integrity. 

Once you are done with editing the data, you can either save it to an *.ecd file in your PC with 

Save as… or program it to the hardware EDID memory with Write. 
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EDID Editor 

You can edit the EDID structures of the data in the HEX Editor by clicking EDID Editor. 

EDID Editor is launched in a separate pop-up window. Please see the description of the EDID 

editor in Chapter EDID Editor later in this document. 
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DPCD Tab 
The DPCD tab is enabled with UCD Pro for DP Sink license. 

DPCD tab is a tool for monitoring and editing the DPCD registers of the UCD-300 Sink. 

The tool consists of two independent monitoring and editing windows for the DPCD data. The 

user can freely select the the DPCD address areas shown on each panel.  

The DPCD Decoder panel on the right hand side shows the interpretation of the DPCD byte 

selected on the monitoring windows. The selected byte is shown with a green outline.  

In the combo box above the DPCD Decoder window you can select how the DPCD data is 

interpreted, either as DP 1.1 DPCD, or as DP 1.2 DPCD with Detailed Capability Info selected 

or not (DETAILED_CAP_INFO_AVAIL = 1/0). 

By clicking Refresh you can re-read the data from the DPCD registers to the window in 

question.  

By clicking Write Changes you can write the portion of data shown in the window in question 

to the DPCD registers. 

By clicking Set Reference you can store currently shown data as a reference for comparison.  

When you refresh the data from the DPCD registers the changed bytes will be highlighted with 

gray background. 
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The fields edited by the user will be highligted with red color. 

Saving and Loading DPCD Content 

You can save the DPCD data in the address areas that you selected for the two windows as a 

file in your PC. You can save the content in three alternative formats: 

• Binary DPCD Fata File format (*.DPD). This is Unigraf proprietary format. You can 

also load the DPCD content stored in this format. 

• Comma Separated Values (*.CSV) for loading the data to a spreadsheet. 

• HEX Dump (*.HEX) in a human readable text format. 

 By Clicking Save you will be able to select the location and the format of the file.  

 By Clicking Load you can load DPCD data saved in DPCD Data File (*.DPD) format to the 

editor.  

 To program the data into the DPCD registers of UCD-300 Local Sink click Write Changes. 

Note - Writing DPCD data to the DPCD registers of the UCD-300 Local Sink will potentially 

affect the status and capabilities of UCD-300 as seen by the upstream source. 

- User control like Link Training or mode changes will modify the content of the DPCD 

registers 

- During a reboot of UCD-300 the DPCD registers will be returned to their default 

values 
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HDCP Tab 
HDCP tab is enabled with UCD Pro for DP Sink license. 

HDCP tab is the dialog for monitoring the HDCP (for High-Bandwith Digital Content 

Protection) status and controlling the HDCP capabilities of the connected UCD-300 device. 

Status 

The status field indicates the HDCP status of the connected UCD-300 device. 

Active: The link between UCD-300 and the upstream source has been encrypted. 

Authenticated: The HDCP handshake between the UCD-300 and the upstream source has been 

completed successfully. 

Declared as HDCP capable: The UCD-300 unit recognizes HDCP handshake messages. 

Keys loaded: The HDCP keys are loaded to the UCD-300 unit. 

Configuration 

HDCP Capable: To disable HDCP uncheck the box. 

Keys 

You can select if you are using Production or Facsimile HDCP keys. To remove the keys, 

select None.  
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HDCP 1.3 vs. HDCP 2.3 

UCD-300 devices support by default HDCP 1.3 standard with DisplayPort. The functionality 

supporting HDCP 2.3 is enabled with HDCP 2.3 Support license 
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SDP Tab 
SDP Tab is enabled with UCD Pro for DP Sink license. 

In SDP Tab you will be able to monitor the Secondary-Data Packets sent by the Source device. 

Click Update to re-read the data. 

SDP Tab displays in hexadecimal format the following received SDP packets: 

• Audio_TimeStamp 

• Audio_Stream 

• Extension 

• Audio_CopyManagement 

• ISRC 

• Video Stream Configuration (VSC) 

• Camera Generic 0 

• Camera Generic 1 

• Camera Generic 2 

• Camera Generic 3 

• Camera Generic 4 

• Camera Generic 5 

• Camera Generic 6 

• Camera Generic 7 

• Vendor-Specific Infoframe packet 

• AVI InfoFrame packet 

• Source Product Descriptor InfoFrame packet 

• Audio InfoFrame packet 

• MPEG Source InfoFrame packet 

• Dynamic Range and Mastering InfoFrame 

• Picture Parameter Set (PPS) 
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Source DUT Testing Tab 
Source DUT Testing Tab is enabled with UCD Pro for DP Sink license. 

Please refer to Appendix E later in this document for description of the tests available. Source 

DUT Testing enables the execution of HDCP 2.3 Compliance Tests for a DP Source DUT. 

Source DUT Testing enables testing of a DP Source DUT. Please refer to Appendix E of this 

document to get a full definition of the Test Cases and test parameters. 

Select the tests for execution by clicking the selector  in the left hand side of the 

corresponding row. 

Clicking Configure… opens a dialog for defining the test parameters for that set. Please refer 

to Test Parameters below for description. 

Parameters from Test descriptor files can be loaded with Import and stored with Export. Please 

refer to chapter Exporting Tests for TSI later in this document. 

 Run the tests by clicking Run Selected. By clicking Abort you can stop the sequence. 

You can control the test flow either with Repeats of the test sequence, Delay between 

individual tests or Stop on Failure that stops the whole sequence if one of the tests fail. 

At the completion of each test the result of the test is indicated in the matrix on the right hand 

side of the test panel. For each test the matrix lists the number of occurrences of each result and 

the number of tries performed. 

Click Save Report to generate a HTML report file for sharing the results with other parties for 

viewing without UCD Console. 

By clicking Clear All you can clear all results – the test log and the results matrix. 
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Test Parameters 
Each test set has its dedicated set of test parameters. You can open a dialog for defining the 

parameters by clicking  button in the set header. 

Parameters of CRC Test Set 

CRC Video test parameters dialog allows you to define the test duration, number of frames 

captured, and errors allowed. It allows you to define the frame size and capture. 

Click Capture now to record Reference CRCs. Please define the number of frames used as 

reference – either one or the number of frames in the predefined test sequence.  

Parameters of Electrical Test Group (UCD-301 only) 

Each test in the Electrical test set uses parameters to control test execution and acceptance 

criteria. Parameters for all tests are collected in the dialog Electrical test parameters.  
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HDCP CTS Test Set 

The HDCP Tests have their own dialog 

Presets 

In both dialogs you can save the selected parameters as Presets. Please click Presets… to save 

your configuration. If you have saved configuration Presets, you can load one of the saved 

ones, save a new Preset or delete a Preset. 

Exporting Tests for TSI 
Unigraf UCD Console includes a feature rich Software Development Kit (SDK) for use in 

automated testing. The SDK is called Test Software Interface (TSI). TSI allows for an easy 

integration of Production and R&D testing routines into an automated test system environment. 

Please refer to TSI documentation found in additional Unigraf manuals for details. 

The tests included in UCD Console’s Source DUT Testing tab and Sink DUT Testing tab can 

be executed in TSI environment. A straightforward way is to use UCD Console’s Tools > 

TSI Integration dialog to create the necessary files for TSI environment and use Export 

function in DUT Testing tabs to include the intended tests. 

Export: Save parameters of the selected test to a file. If TSI Integration is enabled in  

Tools > Options, also the test is appended into ‘Run Test’ file in TSI workspace folder. 

Import: Recall parameters from configuration file. If TSI Integration is enabled in Tools > 

Options, parameters are imported from a file in TSI workspace folder 
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 HDMI REFERENCE SOURCE 

HDMI Reference Source function is available in UCD-323 HDDP Dual. In HDMI Reference 

Source role, the device is using one output channel, HDMI Source (HDMI TX). The 

corresponding vertical tab can be seen on the left edge of the GUI. 

The horizontal tabs on the top of the GUI enable the various functions available for the output 

channel. Some of the tabs are enabled by default, some only when an applicable license is 

included. DPTX features the following functions. 

• Video pattern generator (Pattern Generator). Enabled by default. 

• Status information and control of the downstream link (Link). Enabled by default. 

• EDID editor (EDID). 

• HDCP status monitor and control (HDCP). 

Pattern Generator Tab 
Pattern Generator tab is enabled by default. 
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Predefined Timings 

UCD-300 includes a set of common predefined video timings. Please find a list of the timings 

with their major details in Appendix C of this document. 

Color Mode 

RGB color mode with full range quantization levels will be used with all patterns except with 

Color Square pattern. This pattern allows the user to select RGB, YCbCr 4:4:4, YCbCr 4:2:2 

and YCbCr 4:2:0 color modes. When YCbCr is selected, the Colorimetry dropdown box is 

enabled and allows selection between ITU-709 and ITU-601. Please find a description of the 

available test patterns in Appendix D of this document. 

Color Depth 

You can set the color depth used. The available color depths are: 8, 10, 12 and 16 bpc. 

Predefined Video Patterns 

UCD-300 has a set of predefined patterns and a possibility to user defined custom pattern. You 

can select the pattern in the provided combo box. By selecting Disabled you can have the links 

activated but no video data transferred. 

Please find a description of the available test patterns in Appendix D of this document. 

Custom Image Patterns 

BMP, PNG, JPG and TIFF files can be loaded from the PC to be used as custom images. The 

bitmaps will be aligned to the top left hand side corner, displayed at the original resolution, no 

scaling, cropped to the active area. Select Custom Image pattern. 

Pattern Generator Settings 

In order to avoid sourcing invalid video mode combinations, the new settings need to be 

validated by the user by clicking Apply. Automatic validation will be applied when Auto-

apply when valid is checked. The situation that parameters have been changed but not applied 

is indicated by bold values of the parameter. 

Note Please note that the changes in Pattern Generator tab will not be applied unless the user 

validates them by clicking Apply or when Auto-apply when valid is checked. 
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Custom Timing 

Custom Timing feature is enabled with UCD Pro for HDMI Source license. 

The timing parameters can be modified by selecting the Custom check-box and editing the 

fields of the matrix. Enable the new parameters by clicking Apply button. 

Manage Timings 

Custom timings can also be created and edited with pop-up Timing Editor. Launch the editor 

by clicking Manage Timings. 

 In order to create a new custom timing based on one of the standard fixed, timings select the 

fixed timing and change its name and click Add new timing to store. 

 In order to modify an existing custom timing, select it, modify and click Update timing. 

The dialog will make a sanity check for the values entered and will warn the user for any 

combinations that cannot be used. 

Customize Timings List 

The timings are shown on the pull-down menu by un-checking the Show box. The timings will 

remain in the list and can be brought back to the pull-down menu, when needed. 
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Audio Generator Tab 
Audio Generator tab is enabled by default. 

Audio generator allows the user to play LPCM audio generated internally or from files in 

WAV format. 

 To load internally generated audio, select Generate audio, and adjust the controls to the 

desired audio format. 

 To load an audio file from your PC, select Load audio from file, click the Open WAV file… 

button, browse and select the file and click Open 

 To play the selected audio content, click the Play  button. 

The content will be looped until the Stop  button is clicked.  

Audio Status in the top of the tab indicates the type of the currently played audio content.  



 HDMI Reference Source  

 59.  

Link Tab 
Link tab is enabled by default. 

The Link tab shows the status and control items for the HDMI link. 

HPD 

The status LED indicates the state of the HPD signal Asserted (logical “high”) or De-asserted 

(logical “low”). 

Transmitter 

The panel shows the link mode used, the clock information and the status of the video and data 

scrambling. 

HDMI Behavior 

Select between HDMI 1.4 and HDMI 2.0 behaviors 

TMDS Control 

Mode: Select between HDMI and DVI modes. In DVI mode no audio and metadata are sent 

and color depth limited to 24 bpp maximum. 

Link Mode: Select between 3.4 Gbps (3G) and 6.0 Gbps (6G) TMDS Link Rate 

Enable Scrambler: Enable or disable scrambling of the TMDS data channels. 

Status 

Mode: Indication of the HDMI/TMDS mode (HDMI/DVI) In DVI mode no audio and 

metadata are sent, and color depth limited to 24 bpp maximum. 

Behavior: Status of the HDMI Mode (HDMI 1.4 / HDMI 2.0). 

TMDS Bit Clock Ratio: Status of (TMDS Bit Period) / (TMDS Clock Period) ratio (1/10 or 

1/40) 

Scrambling: Status of Scrambling_Enable bit (1=LED on; 0=LED off) 

Video: Status of video sent. 
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Receiver / Sink Capabilities 

Status of connected HDMI Sink device. 

Mode: Status of Max_TMDS_Character_Rate byte in the sink’s VSBD 

Behaviour: Used HDMI mode 

TMDS Bit Clock Ratio: Status of the TMDS_Bit_Clock_Ratio (1/10 / 1/40) 

FRL Support: Sink’s FRL support level as indicated in sink’s HF-VSDB 

VRR Support: Lowest frame rate and upper limit of the frame rate that sink is able to support 

using Variable Refresh Rate as indicated in sink’s HF-VSDB 

ALLM Support: Indication of Auto Low-Latency Mode support in sink’s HF-VSDB 

Error Counters 

Status of SCDCS Character Error Detection registers. Only counters Lane 0 to Lane 2 are used 

in UCD-323. 
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EDID Tab 
EDID tab is enabled with UCD Pro for HDMI Source license. 

EDID tab will enable analyzing and saving the EDID read from the connected Sink device. 

There are three basic functions: 

• Read the contents of the EDID of the downstream sink over the HDMI link.  

• Load and save EDID data files in the host PC 

• Edit the EDID contents 

 

EDID Files 

With Load… and Save as… you can read and write a hex EDID file from your PC. Please 

note that the program does not alter the contents of the EDID file or verify its integrity during 

load and save operation. 

Note Currently the EDID Editor does not support Display ID. You can however modify hex 

EDID files with the HEX Editor or load and program externally generated hex EDID 

files that have Display ID content. 

HEX Editor 

When EDID content is either loaded from a file or read from the hardware EDID memory, it is 

shown in the EDID Data panel on the left hand side of the dialog. You can edit the EDID 

contents by typing over the existing values. The altered content is highlighted with RED. Please 

note that Hex Editor itself does not alter the contents of the EDID data or verify its integrity. 

Once you are done with editing the data, you can either save it to an *.ecd file in your PC with 

Save as… or program it to the hardware EDID memory with Write. 
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EDID Editor 

You can edit the EDID structures of the data in the HEX Editor by clicking EDID Editor. 

EDID Editor is launched in a separate pop-up window. Please see the description of the EDID 

editor in Chapter EDID Editor later in this document. 
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HDCP Tab 
HDCP tab is enabled with UCD Pro for HDMI Source license. 

HDCP tab is the dialog for monitoring the HDCP (for High-Bandwith Digital Content 

Protection) status and controlling the HDCP capabilities of the connected UCD-300 device. 

Status 

The status field indicate the HDCP status of the connected UCD-300 device. 

Active: The stream between UCD-300 and the downstream sink has been encrypted. 

Authenticated: The HDCP handshake between the UCD-300 and the sink unit has been 

completed successfully. 

Authentication in progress: The HDCP handshake is in process between the UCD-300 and the 

downstream sink unit. 

Keys loaded: The HDCP keys are loaded to the UCD-300 unit. 

Configuration 

Authenticate: Perform the HDCP initiation handshake between the UCD-300 and the sink unit. 

Enable encryption: Check to enable the encryption of the stream between UCD-300 and the 

downstream sink. 

Keys 

You can select if you are using Production or Facsimile HDCP keys. To remove the keys, 

select None.  
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HDCP 1.4 vs. HDCP 2.3 

UCD-300 devices support by default HDCP 1.4 standard with HDMI. HDCP 2.3 support is 

enabled with HDCP 2.3 Support license. 

 



 DisplayPort Reference Source  

 65.  

 DISPLAYPORT REFERENCE SOURCE 

DP Reference Source function is available in UCD-323 HDDP Dual. In DisplayPort Reference 

Source role, the device is using one output channel, DisplayPort Source (DPTX). The 

corresponding vertical tab can be seen on the left edge of the GUI.  

The horizontal tabs on the top of the GUI enable the various functions available for the output 

channel. Some of the tabs are enabled by default, some only when an applicable license is 

included. DPTX features the following functions. 

• Video pattern generator (Pattern Generator). Enabled by default. 

• Status information and control of the downstream link (Link). Enabled by default. 

• EDID editor (EDID). 

• DPCD monitor (DPCD) 

• HDCP status monitor and control (HDCP). 

Pattern Generator Tab 
You can enable the DP Reference Source role either with or without the support to Multi-

streaming (MST). The names of the roles are DisplayPort Reference Source MST2 and 

DisplayPort Reference Source SST. The two roles have a slightly different pattern generator 

functionality. 

Role Features 

DisplayPort Reference Source SST Single stream only 

• 7 fixed patterns 

• 3 adjustable and 2 special patterns 

• Custom bitmap patterns 

• Deep color 

HDCP 1.3 and HDCP 2.3. support 

DisplayPort Reference Source MST2 Up to two DP streams  

• 7 fixed patterns 

HDCP 1.3 and HDCP 2.3. support 
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Please find below Pattern Generator tab in DisplayPort Reference Source MST2 mode. 

Please find below Pattern Generator tab in DisplayPort Reference Source SST mode. 

Note The video modes that can be used in MST streams are limited by the overall capability 

of the DisplayPort link and the capability of the connected DisplayPort Sink or Branch 

device.  
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Predefined Timings 

UCD-300 includes a set of common predefined video timings. Please find a list of the timings 

with their major details in Appendix C of this document. 

Color Mode 

RGB color mode with full range quantization levels will be used with all patterns except with 

Color Square Pattern. This pattern allows the user to select RGB, YCbCr 4:4:4, YCbCr 4:2:2 

and YCbCr 4:2:0 color modes. When YCbCr is selected, the Colorimetry dropdown box is 

enabled and allows selection between ITU-709 and ITU-601. Please find a description of the 

available test patterns in Appendix D of this document. 

Color Depth 

You can set the color depth used. The available color depths are: 6, 8, 10, 12 and 16 bpc. Color 

depth 6 bpc is only available with RGB. 

Predefined Video Patterns 

UCD-300 has a set of predefined patterns and a possibility to user defined custom pattern. You 

can select the pattern in the provided combo box. By selecting Disabled you can have the links 

activated but no video data transferred. 

Please find a description of the available test patterns in Appendix D of this document. 

When MST mode is selected, full selection of test patterns is available only in stream 0 

Custom Image Patterns 

BMP, PNG, JPG and TIFF files can be loaded from the PC to be used as custom images. The 

bitmaps will be aligned to the top left hand side corner, displayed at the original resolution, no 

scaling, cropped to the active area. Select Custom Image pattern. 

Enable / Disable Multistreaming 

In DisplayPort Reference Source MST2 mode you can switch between Single Stream and 

Multistream operation of the source with MST check box. When MST is selected you can 

define the number of streams enabled in Number of streams. Currently only up to 2 streams 

are supported. 

Pattern Generator Settings 

In order to avoid sourcing invalid video mode combinations, the new settings need to be 

validated by the user by clicking Apply. Automatic validation will be applied when Auto-

apply when valid is checked. The situation that parameters have been changed but not applied 

is indicated by bold values of the parameter. 

Note Please note that the changes in Pattern Generator tab will not be applied unless the user 

validates them by clicking Apply or when Auto-apply when valid is checked. 
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Custom Timing 

Custom Timing feature is enabled with UCD Pro for DP Source license. 

The timing parameters can be modified by selecting the Custom check-box and editing the 

fields of the matrix. Enable the new parameters by clicking Apply button. 

Manage Timings 

Custom timings can also be created and edited with pop-up Timing Editor. Launch the editor 

by clicking Manage Timings. 

 In order to create a new custom timing based on one of the standard fixed, timings select the 

fixed timing and change its name and click Add new timing to store. 

 In order to modify an existing custom timing, select it, modify and click Update timing. 

The dialog will make a sanity check for the values entered and will warn the user for any 

combinations that cannot be used. 

Customize Timings List 

The timings are shown on the pull-down menu by un-checking the Show box. The timings will 

remain in the list and can be brought back to the pull-down menu, when needed. 
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Audio Generator 
Audio Generator tab is enabled by default. 

Audio generator allows the user to play LPCM audio generated internally or from files in 

WAV format. 

 To load internally generated audio, select Generate audio, and adjust the controls to the 

desired audio format. 

 To load an audio file from your PC, select Load audio from file, click the Open WAV file… 

button, browse and select the file and click Open 

 To play the selected audio content, click the Play  button. 

The content will be looped until the Stop  button is clicked.  

Audio Status in the top of the tab indicates the type of the currently played audio content.  
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Link Tab 
Link tab is enabled with UCD Pro for DP Source license. The Link tab shows the status and 

control items for the DisplayPort link. 

HPD 

The status LED indicates the state of the HPD signal Asserted (logical “high”) or De-asserted 

(logical “low”). 

Link status 

The panel shows the result of the link training with the connected downstream sink and status 

of connection features. 

Output Level 

Override output level and pre-emphasis values selected during link training. Click Apply 

Overrides to validate changes. 

Note Please note that connected Sink and Source actively maintain the link. If the override 

settings result in link failure, the link will be automatically re-trained and proper values 

set. 

Link configuration 

Set target capabilities for the link training. Click Link Training to apply.  

Scrambler Reset 

Selection of the value to which the Linear Feedback Shift Register (LFSR) is reset during 

scrambler reset. 

In Auto mode UCD verifies that connected DP Sink supports eDP and Alternate Scrambler 

Seed, and then applies FFFEh. If not FFFFh will be used. 
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Fast Link Training 

Click Fast LT to initiate a link training without AUX transactions. The procedure will be the 

following: 

1. Send idle for 10 µs 

2. Send TPS1 for 1 ms 

3. Send TPS2/3/4 for 1 ms 

4. Send idle for 10 µs 

5. Send video 

Link Pattern 

Select between Active video and audio, Idle pattern, or special bit patterns. 

When Force Active Video option is selected, character error messages from sink will not 

interrupt video transmission. 

When Force Idle Pattern is selected, Link Training and Active Video will not be initiated 

even after a replug. 

Note Please note that except Active video, the patterns do not carry video and audio. They are 

special bit combinations used for development purposes. When selecting Active Video 

(or Force Active Video) normal audio and video are being transmitted over the link. 

CRC 

The 16-bit CRC (checksum, cyclic redundancy check) values of the three color components 

calculated by the Sink hardware. 
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EDID Tab 
EDID tab is enabled with UCD Pro for DP Source license. 

 

EDID tab will enable analyzing and saving the EDID read from the connected Sink device. 

There are three basic functions: 

• Read the contents of the EDID of the downstream sink over the DisplayPort link.  

• Load and save EDID data files in the host PC 

• Edit the EDID contents 

 

EDID Files 

With Load… and Save as… you can read and write a hex EDID file from your PC. Please 

note that the program does not alter the contents of the EDID file or verify its integrity during 

load and save operation. 

Note Currently the EDID Editor does not support Display ID. You can however modify hex 

EDID files with the HEX Editor or load and program externally generated hex EDID 

files that have Display ID content. 

HEX Editor 

When EDID content is either loaded from a file or read from the hardware EDID memory, it is 

shown in the EDID Data panel on the left-hand side of the dialog. You can edit the EDID 

contents by typing over the existing values. The altered content is highlighted with RED. Please 

note that Hex Editor itself does not alter the contents of the EDID data or verify its integrity. 

Once you are done with editing the data, you can either save it to an *.ecd file in your PC with 

Save as… or program it to the hardware EDID memory with Write. 
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EDID Editor 

You can edit the EDID structures of the data in the HEX Editor by clicking EDID Editor. 

EDID Editor is launched in a separate pop-up window. Please see the description of the EDID 

editor in Chapter EDID Editor later in this document. 
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DPCD Tab 
The DPCD tab is enabled with UCD Pro for DP Source license. 

DPCD tab is a tool for monitoring and editing the DPCD registers of the connected 

Downstream Sink. 

The tool consists of two independent monitoring and editing windows for the DPCD data. The 

user can freely select the the DPCD address areas shown on each panel.  

The DPCD Decoder panel on the right hand side shows the interpretation of the DPCD byte 

selected on the monitoring windows. The selected byte is shown with a green outline.  

In the combo box above the DPCD Decoder window you can select how the DPCD data is 

interpreted, either as DP 1.1 DPCD, or as DP 1.2 DPCD with Detailed Capability Info selected 

or not (DETAILED_CAP_INFO_AVAIL = 1/0). 

By clicking Refresh you can re-read the data from the DPCD registers to the window in 

question.  

By clicking Write Changes you can write the portion of data shown in the window in question 

to the DPCD registers. 

By clicking Set Reference you can store currently shown data as a reference for comparison.  

When you refresh the data from the DPCD registers the changed bytes will be highlighted with 

gray background. 
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The fields edited by the user will be highligted with red color. 

Saving and Loading DPCD Content 

You can save the DPCD data in the address areas that you selected for the two windows as a 

file in your PC. You can save the content in three alternative formats: 

• Binary DPCD Fata File format (*.DPD). This is Unigraf proprietary format. You can 

also load the DPCD content stored in this format. 

• Comma Separated Values (*.CSV) for loading the data to a spreadsheet. 

• HEX Dump (*.HEX) in a human readable text format. 

 By Clicking Save you will be able to select the location and the format of the file.  

 By Clicking Load you can load DPCD data saved in DPCD Data File (*.DPD) format to the 

editor.  

 In order to program the data into the DPCD registers of UCD-300 Local Sink click Write 

Changes. 

Note - Writing DPCD data to the DPCD registers of the Sink will potentially affect the status 

and capabilities of sink as seen by the source. 

- User control like Link Training or mode changes will modify the content of the DPCD 

registers 
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HDCP Tab 
HDCP tab is enabled with UCD Pro for DP Source license. 

HDCP tab is the dialog for monitoring the HDCP (for High-Bandwith Digital Content 

Protection) status and controlling the HDCP capabilities of the connected UCD-300 device. 

Status 

The status field indicate the HDCP status of the connected UCD-300 device. 

Active: The stream between UCD-300 and the downstream sink has been encrypted. 

Authenticated: The HDCP handshake between the UCD-300 and the sink unit has been 

completed successfully. 

Authentication in process: The HDCP handshake is in process between the UCD-300 and the 

downstream sink unit. 

Keys loaded: The HDCP keys are loaded to the UCD-300 unit. 

Content level: Selection of Type 1 content ensures that content encryption is done with HDCP 

version 2.2 or higher. 

Configuration 

Authenticate: Perform the HDCP initiation handshake between the UCD-300 and the sink unit. 

Enable encryption: Check to enable the encryption of the stream between UCD-300 and the 

downstream sink. 

Keys 

You can select if you are using Production or Facsimile HDCP keys. To remove the keys, 

select None.  
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HDCP 1.3 vs. HDCP 2.3 

UCD-300 devices support by default HDCP 1.3 standard with DisplayPort. The functionality 

supporting HDCP 2.3 is enabled with HDCP 2.3 Support license. 
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Sink DUT Testing Tab 
Sink DUT Testing Tab is enabled with UCD Pro for DP Source license. 

Please refer to Appendix E later in this document for description of the tests available. Sink 

DUT Testing enables the execution of HDCP 2.3 Compliance Tests for a DP Sink DUT. 

Sink DUT Testing enables testing of a DP Sink DUT. Please refer to Appendix E of this 

document to get a full definition of the Test Cases and test parameters. 

Select the tests for execution by clicking the corresponding row. 

Clicking Configure… opens a dialog for defining the test parameters for that set. Please refer 

to Test Parameters below for description. 

Parameters from Test descriptor files can be loaded with Import and stored with Export. Please 

refer to chapter Exporting Tests for TSI later in this document. 

 Tests are started by clicking Run Selected. By clicking Abort the sequence is stopped. 

Test flow can be controlled with Repeats of the test sequence, Delay time between individual 

tests or Stop on Failure that stops the whole sequence if one of the tests fail. 

At the completion of each test the result of the test is indicated in the matrix on the right hand 

side of the test panel. For each test the matrix lists the number of occurrences of each result and 

the number of tries performed. 

Click Save Report to generate a HTML report file for sharing the results with other parties for 

viewing without UCD Console. 

By clicking Clear All the test log and the results matrix are cleared. 
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Test Parameters 
Each test set has its dedicated set of test parameters. Open a dialog for defining the parameters 

by clicking Configure…. 

HDCP CTS Test Set 

The HDCP Tests have test timeout as a given parameter. 

Presets 

You can save the selected parameters as Presets. Please click Presets… to save your 

configuration. If you have saved configuration Presets, you can load one of the saved ones, 

save a new Preset or delete a Preset. 

Click Clear Results to clear the result panel. 

Exporting Tests for TSI 
Unigraf UCD Console includes a feature rich Software Development Kit (SDK) for use in 

automated testing. The SDK is called Test Software Interface (TSI). TSI allows for an easy 

integration of Production and R&D testing routines into an automated test system environment. 

Please refer to TSI documentation found in additional Unigraf manuals for details. 

The tests included in UCD Console’s Source DUT Testing tab and Sink DUT Testing tab can 

be executed in TSI environment. A straightforward way is to use UCD Console’s Tools > 

TSI Integration dialog to create the necessary files for TSI environment and use Export 

function in DUT Testing tabs to include the intended tests. 

Export: Save parameters of the selected test to a file. If TSI Integration is enabled in  

Tools > Options, also the test is appended into ‘Run Test’ file in TSI workspace folder. 

Import: Recall parameters from configuration file. If TSI Integration is enabled in Tools > 

Options, parameters are imported from a file in TSI workspace folder 
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 S/PDIF REFERENCE SINK 

S/PDIF Reference Sink function is available in UCD-301 Digital. In S/PDIF Reference Sink 

role the device is using one input channel, S/PDIF (SPDIF). The corresponding vertical tab can 

be seen on the left edge of the GUI.  

This role contains only one tab: 

• Audio monitoring and saving (Audio). Enabled by default. 

Audio Tab 
Audio tab is enabled by default. Audio tab has a preview of the audio signal format and the 

controls for audio playback and recording. 

The audio signal format is shown in three ways 

• The ‘oscilloscope’ panel displays the waveforms of the received audio channels.  

• The frequency spectrum of the audio is shown in the lower panel. The range of the 

spectrum display is from 0 to 24 000 Hz. The amplitude scale of the spectrum display can 

be selected between ‘Linear’ to 80 dB. 

• The horizontal sound level indicator is in the bottom of the dialog.  

The span of the preview window is defined with Audio preview size found in Tools > Options 

dialog. The value is given in ksamples (1024 samples). The relation between the preview 

window span in milliseconds (msec) and the value given in Audio preview size depends on the 

sampling frequency. Please do not exceed the Audio buffer size set in the same dialog. 

Disable / Enable Preview 

Use this button to control capturing the audio data. 
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Playback device selection 

You can enable audio playback in your PC by selecting the Playback check-box. Use the 

combo-box to select the audio device in the host PC through which the captured audio is 

played. By default, the Default Audio device of your PC is chosen. Please Disable Preview in 

order to make changes. 

Note Please note that the audio capabilities of the audio playback device of your PC are not 

automatically reflected in the audio capabilities description in UCD-300 EDID. Since 

UCD-300 is not performing any audio format conversion, it might occur that the source 

provides an audio format that the selected playback device is not supporting. In case a 

conflict occurs, please change manually the EDID content or disable audio playback in 

order to monitor the waveforms in UCD Console. 

Refresh audio device list 

 

Click here to re-read the list of audio devices after making changes to the host PC 

configuration. 

Audio Buffer Size 

You can define the amount of buffering used in the data transfer between the UCD-300 unit 

and the PC. Audio buffer size can be found in Tools > Options dialog. Increased buffer size 

will ensure a smooth audio output, but will also increase the delay between the capture of the 

audio stream and its playback. 

Start audio recording 

 

Clicking the button you can start or stop recording the captured audio in the PC using 

WAVeform audio format (*.wav) format. In the pop-up dialog you can define the recording 

duration. The folder where the audio file will be saved can be selected in File > Options. 

Input audio mode 

 

This field (in the bottom of the dialog) indicates detected audio mode in the input stream. 
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 COMPLIANCE TESTS 

Compliance test capability is a license enabled add-on to UCD Console.  

The tests are included in the GUI software, license codes enable the tests for use. Please refer 

to Appendix B Licensing for details. The list of compliance tests that UCD Console supports, 

please refer to document DP CTS Tool Options for Unigraf UCD-3XX.pdf. It can be 

downloaded in Unigraf Document Center at https://www.unigraf.fi/documents/. If you have 

any additional questions, please contact Unigraf or your local representative. 

Compliance tests (CTS Tests) are part of tests included in Source DUT Testing tab of DP RX 

and Sink DUT Testing tab of DP TX. 

The tests cases are divided to test categories as described in Appendix E of this document. Each 

test category can be found in its dedicated sub-tab. The sub-tabs as in turn enabled by the 

licenses present in user’s PC. Please refer to chapter 5 License Manager earlier in this 

document. 

https://www.unigraf.fi/documents/
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Test Parameters 
Before running the tests, capabilities of the DUT has to be defined for the test engine. Each test 

category has its dedicated test parameter dialog. Click Configure… in Source DUT Testing or 

Sink DUT Testing tab to open the parameter dialog. 

For a detailed description of capabilities listed on the tab please refer to document 

HDCP 2.3 on DisplayPort Compliance Test Specification 

Note Please make sure that the capability tables are completed before running the tests. The 

result of the test might be misleading if the DUT capabilities and the table do not 

match. 

Saving Test Parameters 
Test parameters can be saved for later use in two ways: internally or externally in a file. 

In parameter dialog the parameter set can be saved as an internal Preset. 

In Source or Sink DUT Testing tab Export saves test definitions of each selected test in a 

separate file. Import loads the parameters back to UCD Console. They can be run with 

Unigraf TSI. Please refer to chapter 7.3.6 Running Tests in document TSI-X_Reference.pdf in 

UCD Console release package. 
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Exporting Tests for TSI 
Unigraf UCD Console includes a feature rich Software Development Kit (SDK) for use in 

automated testing. The SDK is called Test Software Interface (TSI). TSI allows for an easy 

integration of Production and R&D testing routines into an automated test system environment. 

Please refer to TSI documentation found in additional Unigraf manuals for details. 

The tests included in UCD Console’s Source DUT Testing tab and Sink DUT Testing tab can 

be executed in TSI environment. A straightforward way is to use UCD Console’s Tools > 

TSI Integration dialog to create the necessary files for TSI environment and use Export 

function in DUT Testing tabs to include the intended tests. 

Export: Save parameters of the selected test to a file. If TSI Integration is enabled in  

Tools > Options, also the test is appended into ‘Run Test’ file in TSI workspace folder. 

Import: Recall parameters from configuration file. If TSI Integration is enabled in Tools > 

Options, parameters are imported from a file in TSI workspace folder 
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Running CTS Tests 
Source DUT Testing and Sink DUT Testing tabs include the tests enabled with the set of 

licenses present in UCD Console. The tests are grouped in test set tabs. In tabs the tests are 

listed by the test name and reference number as presented in applicable compliance test 

specification. UCD-300 firmware implements the test according to the test specification.  

For running a test, select it and click Run selected. For selecting multiple consecutive tests in 

the list hold down the Shift key of your keyboard while selecting the tests. For selecting 

multiple individual tests hold down the Ctrl key in your keyboard while selecting. 

Repeats defines number of test-runs and the Delay time delay between the tests. When 

repeating a sequence of tests, all selected tests are performed in each repetition. E.g. when you 

repeat tests 1, 2 and 3 two times, the sequence is: 1, 2, 3, 1, 2, 3. 

Test flow parameters like Test timeout and Test cycle delay can be defined in Test Parameter 

dialog launched by clicking Configure…. 

Selecting Stop on Failure stops execution of a series of tests in case a failure is found. 

For clearing the Status Log and the Results matrix, click Clear All. 
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Evaluating CTS Test Results 
The test procedure advancement can be monitored in the Test Log panel. It describes the steps 

of each individual test in the way defined in the corresponding VESA Compliance Test 

Specification. Please use the Status Log and Specification side by side when interpreting the 

results. 

At the completion of each test the result of the test is indicated in the matrix on the right hand 

side of the test panel. For each test, the matrix lists the number of occurrences of each result 

and the number of tries performed. 

Test Report 
Results of the test can be saved as a report in HTML format.  
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Click Save Report in UCD Console. A dialog will open where information about the DUT and 

remarks about the test can be included in the report. Details of the used test equipment and the 

software and firmware version will be added automatically. 

Viewing the CTS Test Report 
The report file can be viewed with any HTML browser. The report has built-in views for 

Report Summary, Test Summary, and individual Test Logs. 
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 EVENT LOG 

The Event Logger (Event Log) vertical tab can be seen on the left edge of the GUI. Event Log 

is enabled with UCD Pro for HDMI Sink, UCD Pro for HDMI Source, UCD Pro for DP Sink 

and UCD Pro for DP Source license. 

Event Log dialog is divided into three panels: Data sources and filters panel on the left enables 

selection of the items to be logged. The selection of data sources is dependent on the role 

selected: DP Input, DP Output, HDMI Input, HDMI Output.  

Data Source 
HDMI 
Input 

DP  
Input 

HDMI 
Output 

DP 
Output 

HPD status ● ● ● ● 

I2C transactions ●  ●  

AUX transaction  ●  ● 

HDMI InfoFrames ●    

DP SDP messages  ●   

Changes in MSA  ●   

Changes in VB-ID  ●   

 

Transaction list in the center panel lists all transactions captured, and the right panel shows the 

parsed transaction data for the line selected in the center panel. 

The transactions are with Time stamps, Type indications, Message source, and raw message 

data. The right panel lists the content of one message. Messages belonging together with the 

selected one are shown in red color.  

 Start event logging by clicking Start Capture and stop it by clicking Stop Capture. 

 You can save transactions in binary *.evt Event Log files by clicking Save. You can recall 

saved Event Log files by clicking Open.  

 By clicking Report you can store event logs as html reports to be shared and viewed with any 

web browser. You are first asked to indicate the file name and location, then you can add 

detailed information about the DUT and the test in free-text Report information.  
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DP AUX Analyzer 
DP AUX Analyzer functionality is enabled with UCD Pro for DP Sink and UCD Pro for DP 

Source license. 

The AUX Analyzer tabs collect AUX Channel Transactions from the Event Log in the 

Transaction list. The user can parse the content of each transaction by clicking the 

corresponding transaction line. The parsed content is in the Message Details panel on the right. 

Please refer to chapter Customizing the Main Window below for details on how to modify the 

content and look of the Transaction list. 

Lines 
The data is organized in lines, each numbered starting from 1 and marked with a timestamp. 

There are four kinds of lines: 

1. Information lines 

Identified by the text “INFO” in their Type column, they provide some useful 

information like the time acquisition has started and stopped or the logical state of the 

inputs, etc. 

2. Transaction lines 

Identified by the text “Native” or “I2C” in their Type column, they report an AUX 

channel data transfer, either a data Request or a data Reply. 

3. Event lines 

Identified by the text “Event” in their Type column, they signal the state change in one 

or more of the monitored inputs. 

4. Sideband Channel Messages 

The Isochronous Transport Service uses the sideband communications over sideband 

channel (AUX CH and HPD) for the management of topology/virtual channel 

connection/Main Link and performs Main Link symbol mapping. 
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5. Error lines 

A line Type reading “Error” marks the detection of an illegal AUX channel data packet. 

An irregular start condition, an irregular stop condition or transfer of a number of bits 

which is not a multiple of 8 are all conditions that cause an error line. 

6. Trace lines 

Combines the data from several lines of a HDCP related message to one entry in 

Message details panel for easier readability. 

Columns 
The data on each line is ordered in columns. Each column provides additional information 

about the data line, facilitating its viewing and interpretation: 

Line 

This column displays the line number, starting from 1, and cannot be hidden. 

Timestamp 

Each line is identified by its timestamp, marking the instant when an event or error was 

detected, or when a data transaction got started. The timestamp can be displayed as a time 

delay from the start of the acquisition (absolute) or from the previous line (relative). The 

timestamp can be displayed in milliseconds or in minutes, seconds and microseconds. 

From 

This column indicates the originator of the data line: 

• “Source” and “Sink” for an AUX channel transaction, respectively a data Request 

and a data Reply. 

• “Source Trace” and “Sink Trace” respectively for Sideband Message data 

Request and Reply. 

• “UCD-300” for error and information lines. 

• “Unknown” for signal state change events. 

Type 

This column provides additional information about the type of the line: 

• “Native” marks Native AUX channel Requests and Replies. 

• “I2C” marks I2C AUX channel Requests and Replies. 

• “Sideband Request” and “Sideband Reply” to mark the Sideband Channel 

messages 

• “Event” is used for signal state change events. 

• “INFO” is used with information lines. 

• “Error” is used for illegal conditions detected on the AUX channel. 

Details 

This column contains an abbreviated description of the line content in textual form. 

Data 

The binary data exchanged during AUX channel transactions, in hexadecimal notation. 

Find 
To locate an access to a DPCD location right-click on the list and select Find… or select 

Ctrl+F from keyboard. To Find again select F3. 
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Message Details 
The Message details panel is used to provide a detailed explanation of the line currently 

selected in the Transaction list. For AUX channel transaction lines, for each of the DPCD 

memory locations affected, the panel lists: 

• All data bytes read or written. 

• All DPCD memory locations affected. 

• The name of the locations and of each of their bit fields. 

• All bit field’s numeric and binary values, together with their decoded value. 

• The Replies outcome (AUX_ACK, AUX_NACK, I2C_DEFER, etc.). 

Customizing the Main Window 
Format of the data shown in the Transaction list and the Message details panels can be altered 

in order to highlight the details of your interest. 

Selecting Data Columns 

The Transaction list can be customized by right-clicking over the list. The pop-up menu allows 

choosing which columns to display, the style of the timestamp and switch between absolute 

and relative timestamps. Filters limit the transactions shown in the list. Please see Filtering 

later in this document. 

Selecting Font and Colors 

Select Tools > Options > AUX Analyzer options tab. Click Select new font and choose the 

font and size used for displaying the Transaction list and the Message details.  
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Transaction List Color Options 

Select the colors for the font and background of various items. 

Highlighted DPCD Address Ranges 

In order to improve the readability of the Transaction list, you can mark the AUX channel 

transactions where a certain DPCD register address or address range is highlighted with a color 

of choice. 

Click Add…, select the access type, start DPCD address and end DPCD address of the range 

in Hex. Click Accept. 

Select the range you just created from the Highlighted DPCD addresses ranges list and click 

the Change test color and Change background color buttons to select the colors desired. 

You can create multiple simultaneous coloring rules to help you get a better view of the data 

captured. 
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Filtering  
Transactions lines shown in the transaction list can be limited by Filtering. The shown lines 

can be selected by: 

• The type of data line 

• The origin of the message 

• The DPCD address range 

Right click > Filters drop down menu lists a set of pre-programmed filters. 

Editing Filters 

From Custom Filter dialog (Tools > Options > Edit Custom Filters …) allows for 

adding and modifying filters. The pre-programmed filters are listed in the dialog. Their 

structure can be copied as bases of your custom filters. It is advisable not to modify the 

pre-programmed filters directly but make copies of them. 

In the Stored custom filter definitions panel, lists currently defined Filters. On the right 

hand side buttons, you can define new Filters, rename or delete them. Their appearance 

in the Filters pull-down menu can also be altered. 

In the Filter Rules panel lower in the dialog you can review and change the Rules in the 

selected Filter. Add… creates new rules, Edit… enables review and editing existing 

Filters and Remove deletes from the Filter definition. 
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When clicking Add… or Edit… Edit Filter Rule dialog opens. The dialog defines the 

action of the rule, events and event details. 

Click Help to show “Help” text also attached to Appendix F of this document. 

Note Please note that Filters are a very powerful tool. They can however unintentionally hide 

valuable data from you. Please be careful when applying custom filters. 

A good practice is to start from an existing filter and gradually add new rules while 

testing their performance.  

 

Note  Filtering and selecting the columns for display do not affect the actual data acquisition. 

All transactions and their full data are always captured. 
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 EDID EDITOR 

The Main Window 

The EDID Editor main window is divided into three logical areas. The bottom part of the 

window contains the command buttons, and the log view. The top-left portion shows the 

currently edited E-EDID blocks in a tree-form, and the top-right portion shows an edit control 

for the currently selected item, possibly a list of sub-keys and their names (The list is not 

shown for all values) and the HEX-view of the block collection. 

Command Buttons 
Load: Load an EDID block collection file from disk. 

Save: Save the current block collection to a disk file. 

Show Hex: Show or Hide the HEX view. 

Show Log: Show or Hide the Log view. 

EDID Editor Features 
The EDID Editor currently supports VESA E-EDID block versions 1.3 and 1.4. As the 

standard defines, the versions 1.0, 1.1 and 1.2 are supposed to be backward compatible, and 

therefore the VESA E-EDID decoder will also show their contents. However, in these cases it 

should be noted that the error checking is not compliant with restrictions given in these older 

versions of the standard. In addition to VESA E-EDID block, the CEA-861 versions 1, 2 and 3 

EDID blocks are also fully supported as well as the VESA Block Map Extension blocks. 

Practically unlimited number of extension blocks may exist in a single collection. The number 

of blocks is limited by VESA Specifications and possibly by available system resources. Most 

EDID blocks contain a structure that is very similar to a tree-structure. The EDID Editor 

decodes each block into a tree-view of the block. The tree-view then contains all values 

contained within the EDID block. The contents can then be easily browsed, using only a few 

mouse clicks. The EDID Editor has a support for automatic variables, such as the block 

checksum. When the user changes a value in an EDID block, the tool will update the checksum 

accordingly. The automatic variables appear as read only values for the user. A log print will 

be made when an automatic variable is updated by the editor.  

HEX View: An optional HEX data display of all blocks in the collection. The view also shows 

the latest changes highlighted. 
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LOG View: An optional LOG view, which will contain log prints generated by the editor. 

Mostly it will list values that have been automatically updated due to edits. 

Editing Tips 
Editing an EDID block is very straightforward, but there are some special cases where the user 

must know how to accomplish certain types of tasks. 

• Enter key will apply text-edit values and combo-box selection. 

• To apply new setting to binary values (ones that show a check-box), please click the Set 

button. 

• When you see a Quick Config button appear below an editor, you can access a 

configuration menu that allows you to quickly select one of multiple pre-defined setup 

options. 

• In CEA-861 blocks, you can add and remove 18-byte descriptors and CEA data blocks by 

setting the values “18-byte Descriptors in this block” and “CEA Data block count”. 

Unfortunately re-arranging the descriptors and CEA data blocks is not supported yet, so 

you need to be careful when editing these. 

• Enter hex values with prefix “0x” or “$”, no prefix means a decimal value. 

• You can always enter HEX or DEC, even if the value is presented as HEX, and/or value 

range is given in HEX. 

• Floating point values must be given with period “.” as decimal separator, even if your 

localization setting defines decimal separator as comma (or other). 

• Remember to click Set after changing a bit-value presented as a single check-box if you 

want the new value applied. 

Note It is recommended that you back up the un-edited EDID contents to a file before editing 

and writing it to the card. 

Saving EDID Data 
When you are done with editing you can either save the EDID contents to a file in the PC or 

bring it in the HEX Editor.  

For saving the data to a file in your PC click Save. 

For bringing the data to the HEX Editor close the EDID Editor window by clicking the 

Window Close button in the top right hand corner of the window. You will be asked if you 

would like to copy and replace the EDID data in the HEX Editor. Click Yes to replace the data, 

click No to discard the modifications.  

When you are back in the HEX Editor, the bytes that the EDID Editor changed are highlighted 

with BLUE BACKGROUND. 
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APPENDIX A. PRODUCT SPECIFICATION 

UCD-323 HDDP Dual 

Inputs DisplayPort™ 1.4a compliant with HBR2 max bit rate (DP in) 

HDMI 2.0 compliant (HDMI in) 

Outputs DisplayPort™ 1.4a compliant with HBR2 max bit rate (DP out) 

HDMI 2.0 compliant (HDMI out) 

Max video mode 4096 × 2160 p60 input and output 

Audio LPCM, 2 – 8 channels, 44.1 to 192 kHz 

Features DisplayPort Tx supports Link Training with LT-Tunable PHY 
Repeaters 

Computer interface USB 3.0 and USB 2.0 

Software Windows 10, 8 and 7 compatible software driver  

UCD Console application for Windows 

Compatible with Unigraf TSI 

Power supply AC/DC Power supply 

(100 to 240 Vac 50/60 Hz input, +12 Vdc output) 

Mechanical Size 281 × 128 × 62 mm 

Weight 0.9 kg w/o power supply 

 

UCD-301 Digital 

Inputs DisplayPort™ 1.4a compliant with HBR2 max bit rate  

HDMI 2.0 compliant  

S/PDIF audio (192 kHz max) 

Max video mode 4096 × 2160 p60 input 

Audio LPCM, 2 – 8 channels, 44.1 to 192 kHz 

Electrical Test Verify electrical continuity of input signals 

Computer interface USB 3.0 and USB 2.0 

Software Windows 10, 8 and 7 compatible software driver 

UCD Console application for Windows 

Compatible with Unigraf TSI 

Power supply AC/DC Power supply 

(100 to 240 Vac 50/60 Hz input, +12 Vdc output) 

Mechanical Size 281 × 128 × 62 mm 

Weight 0.9 kg w/o power supply 

 

All specifications are subject to change without notice. 
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APPENDIX B. LICENSING 

The table below lists all functions in UCD-323 and UCD-301 devices and their licensing. 

Overview 
Input /  
Output  
Role 

Tab 
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H
D

C
P

 2
.3

 C
T

S
 

T
S

I B
as

ic
 (

de
fa

ul
t)

 

T
S

I A
dv

an
ce

d
 

E
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HDMI Reference 
Sink  
(HDMI RX) 

Video preview and saving (Video).  ● ●   ▲ ▲  

Audio monitoring and saving (Audio). ● ●   ▲ ▲  

Status information of the upstream link (Link). ● ●   ▲ ▲  

EDID editor (EDID).  ●    ▲  

HDCP status monitor and control (HDCP)  ● ●   ▲  

InfoFrames  ●    ▲  

Source DUT Testing  ●    ▲ ▲ 

Electrical Test       ▲ 

DisplayPort 
Reference Sink 
(DPRX) 

Video preview and saving (Video).  ● ●   ▲ ▲  

Audio monitoring and saving (Audio). ● ●   ▲ ▲  

Status information of the upstream link (Link). ● ●   ▲ ▲  

Video mode and control of the upstream link (Link).  ●    ▲  

EDID editor (EDID).  ●    ▲  

DPCD editor (DPCD).  ●    ▲  

HDCP status monitor and control (HDCP)  ● ●   ▲  

Source DUT Testing  ●  ■  ▲ ▲ 

Event Log, DP AUX Analyzer  ●      

HDMI Reference 
Source  
(HDMI TX) 

Video pattern generator (Pattern Generator).  ● ●   ▲ ▲  

Audio generator ● ●      

Status information of the downstream link (Link). ● ●      

Control of the downstream link (Link)  ●      

EDID editor (EDID).  ●      

HDCP status monitor and control (HDCP)  ● ●     

DisplayPort 
Reference 
Source  
(DPTX) 

Video pattern generator (Pattern Generator).  ● ●   ▲ ▲  

Audio generator ● ●      

Status information of the downstream link (Link). ● ●   ▲ ▲  

Control of the downstream link (Link)  ●      

EDID editor (EDID).  ●      

HDCP status monitor and control (HDCP)  ● ●     

Sink DUT Testing    ■    

Event Log, DP AUX Analyzer  ●      

SPDIF 
Reference Sink 
(SPDIF) 

Audio monitoring and saving (Audio). 
●   

   
 

In the following pages, please find detailed explanation of the functions and the licensing. Please refer to 

TSI documentation on detailed description of TSI features. 
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Features in UCD-323 and UCD-301  
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Features Available in UCD-323 and UCD-301 with 
Default Feature Set 
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HDMI Reference Sink Video status, preview and saving   
 Audio monitoring, graphical preview and saving   
 Link status, HPD status and control   

 Electrical Test*   

DP Reference Sink Video status, preview and saving 
  

 Audio monitoring, graphical preview and saving   
 Link status, HPD status and control   

 Electrical Test*   

 HDCP 2.3 CTS **   

HDMI Reference Source Video pattern generator (fixed patterns and timings)   
 Audio generator   

 Link status and configuration   

 HPD status   

DP Reference Source Video pattern generator (fixed patterns and timings)   
 Audio generator   

 Link status and configuration   
 HPD status   

 HDCP 2.3 CTS **   

SPDIF Reference Sink Audio monitoring, graphical preview and saving 
 

 

 

*) Available in UCD-301 Digital (P/N 066510) with TSI Electrical Test Set (P/N MT6502) license 

**) Available with HDCP 2.3 CTS for testing Source on DP DUT (P/N MT6634) or HDCP 2.3 CTS for 

testing Sink on DP DUT (P/N MT6636) license 

 

   Feature available in UCD Console 

   Feature available in TSI SDK and API 
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Features Available in UCD-323 and UCD-301 with  
Console Pro Feature Set * 
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HDMI Reference Sink Video status, preview and saving   
 Audio monitoring, graphical preview and saving   
 Link status, HPD status and control   
 HDCP 1.4 status and control   
 HDCP 2.3 status and control ***   
 Infoframe status   
 EDID read and write, EDID Editor   
 Built-in Source DUT tests (ARC, CEC, CRC tests)   
 Electrical Test **   
DP Reference Sink Video status, preview and saving   
 Audio monitoring, graphical preview and saving   
 Link status, HPD status and control 

  
 Video mode and control of the upstream link   
 HDCP 1.3 status and control   
 HDCP 2.3 status and control ***   
 DPCD read and write, DPCD editor   
 Infoframe status   
 EDID read and write, EDID Editor   
 Built-in Source DUT tests (LT test, CRC tests)   
 Electrical Test **   
 HDCP 2.3 CTS ****   
 Event Log, AUX Analyzer   

HDMI Reference Source Video pattern generator (fixed patterns and timings) 
  

 Custom video patterns and timings   
 Audio generator   

 Link status and configuration   
 HPD status   
 HDCP 1.4 status and control   
 HDCP 2.3 status and control ***   

 

contd. … 
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DP Reference Source Video pattern generator (fixed patterns and timings)   
 Custom video patterns and timings   
 Audio generator   

 Link status and configuration   
 HPD status   
 HDCP 1.4 status and control   
 HDCP 2.3 status and control ***   
 HDCP 2.3 CTS ****   
 Event Log, AUX Analyzer   

SPDIF Reference Sink Audio monitoring, graphical preview and saving   

*) Console Pro can be enabled with each interface (DP / HDMI; Sink / Source) separately. TSI 

Advanced feature is delivered with Console Pro feature. 

**) Available in UCD-301 Digital (P/N 066510) with TSI Electrical Test Set (P/N MT6502) license 

***) Available with HDCP 2.3 support (P/N MT6504) license 

****) Available with HDCP 2.3 CTS for testing Source on DP DUT (P/N MT6634) or HDCP 2.3 

CTS for testing Sink on DP DUT (P/N MT6636) license 

 

   Feature available in UCD Console 

   Feature available in TSI SDK and API 
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TSI API Features in UCD-323 and UCD-301 
  



 Appendix B. Licensing  

 104.  

Features Available in UCD-323 and UCD-301 with  
TSI Advanced Test Set (P/N MT6501) 

  

C
on

so
le

 B
as

ic
 

T
S

I A
dv

an
ce

d
 

HDMI Reference Sink Video status, preview and saving   
 Audio monitoring, graphical preview and saving   
 Link status, HPD status and control   
 Video mode and control of the upstream link   
 HDCP 1.4 status and control   

 HDCP 2.3 status and control **   

 Infoframe status (ARC, CEC, CRC tests)   
 EDID read and write, EDID Editor   
 Built-in Source DUT tests (ARC, CEC, CRC tests)   

 Electrical Test *   

DP Reference Sink Video status, preview and saving   
 Audio monitoring, graphical preview and saving   
 Link status, HPD status and control 

  
 Video mode and control of the upstream link   
 HDCP 1.3 status and control   

 HDCP 2.3 status and control **   

 DPCD read and write, DPCD editor   
 SDP status   
 EDID read and write, EDID Editor   
 Built-in Source DUT tests (LT test, CRC tests)   

 Electrical Test *   

 HDCP 2.3 CTS ***   

HDMI Reference Source Video pattern generator (fixed patterns and timings) 
  

 Custom video patterns and timings   
 Link status and configuration   
 HPD status   
DP Reference Source Video pattern generator (fixed patterns and timings)   
 Custom video patterns and timings   
 Link status and configuration   
 HPD status   

 HDCP 2.3 CTS ***   

SPDIF Reference Sink Audio monitoring, graphical preview and saving   

*) Available in UCD-301 Digital (P/N 066510) with TSI Electrical Test Set (P/N MT6502) license 

**) Available with TSI SDK Advanced Test Set with HDCP 2.3 support (P/N MT6516) license 

***) Available with HDCP 2.3 CTS for testing Source on DP DUT (P/N MT6634) or HDCP 2.3 CTS 

for testing Sink on DP DUT (P/N MT6636) license 

 

   Feature available in UCD Console 

   Feature available in TSI SDK and API 
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APPENDIX C: PREDEFINED TIMINGS 
DisplayPort Sink and Source Capability (RGB) 

Description TSI* 
H 

active 
V 

active 
H 

total 
V 

total 
Frame 

rate 

RGB 4:4:4 

6 8  10  12  16  

VESA 640 x 480 @ 60Hz 0 640 480 800 525 60 ● ● ● ● ● 

VESA 800 x 600 @ 60Hz 1 800 600 1056 628 60 ● ● ● ● ● 

VESA 848 x 480 @ 60Hz 2 848 480 1088 517 60 ● ● ● ● ● 

VESA 1024 x 768 @ 60Hz 3 1024 768 1344 806 60 ● ● ● ● ● 

CTA 1280 x 720 @ 60Hz 4 1280 720 1650 750 60 ● ● ● ● ● 

VESA 1280 x 768 @ 60Hz 5 1280 768 1664 798 60 ● ● ● ● ● 

VESA 1280 x 960 @ 60Hz 6 1280 960 1800 1000 60 ● ● ● ● ● 

VESA 1280 x 800 @ 60Hz [RB1] 7 1280 800 1440 823 60 ● ● ● ● ● 

VESA 1280 x 800 @ 60Hz 8 1280 800 1680 831 60 ● ● ● ● ● 

VESA 1280 x 768 @ 60Hz 9 1280 768 1440 790 60 ● ● ● ● ● 

VESA 1280 x 1024 @ 60Hz 10 1280 1024 1688 1066 60 ● ● ● ● ● 

VESA 1360 x 768 @ 60Hz 11 1360 768 1792 795 60 ● ● ● ● ● 

VESA 1400 x 1050 @ 60Hz 12 1400 1050 1560 1080 60 ● ● ● ● ● 

VESA 1600 x 1200 @ 60Hz [RB1] 13 1600 1200 1760 1235 60 ● ● ● ● ● 

VESA 1600 x 1200 @ 60Hz 14 1600 1200 2160 1250 60 ● ● ● ● ● 

VESA 1680 x 1050 @ 60Hz 15 1680 1050 2240 1089 60 ● ● ● ● ● 

VESA 1680 x 1050 @ 60Hz [RB1] 16 1680 1050 1840 1080 60 ● ● ● ● ● 

VESA 1792 x 1344 @ 60Hz 17 1792 1344 2448 1394 60 ● ● ● ● ● 

VESA 1920 x 1080 @ 30Hz [RB1] 18 1920 1080 2080 1096 30 ● ● ● ● ● 

VESA 1920 x 1080 @ 30Hz [RB2] 19 1920 1080 2000 1096 30 ● ● ● ● ● 

CTA 1920 x 1080 @ 30Hz 20 1920 1080 2200 1125 30 ● ● ● ● ● 

VESA 1920 x 1080 @ 60Hz [RB1] 21 1920 1080 2080 1111 60 ● ● ● ● ● 

VESA 1920 x 1080 @ 60Hz [RB2] 22 1920 1080 2000 1111 60 ● ● ● ● ● 

CTA 1920 x 1080 @ 60Hz 23 1920 1080 2200 1125 60 ● ● ● ● ● 

VESA 1920 x 1080 @ 120Hz [RB1] 24 1920 1080 2080 1144 120 ● ● ● ● ● 

VESA 1920 x 1080 @ 120Hz [RB2] 25 1920 1080 2000 1144 120 ● ● ● ● ● 

CTA 1920 x 1080 @ 120Hz 26 1920 1080 2200 1125 120 ● ● ● ● ● 

VESA 1920 x 1440 @ 60Hz 27 1920 1440 2600 1500 60 ● ● ● ● ● 

VESA 2048 x 1536 @ 60Hz 28 2048 1536 2208 1580 60 ● ● ● ● ● 

VESA 2560 x 1440 @ 60Hz 29 2560 1440 2720 1481 60 ● ● ● ● ● 

VESA 2560 x 1080 @ 60Hz 30 2560 1080 3424 1120 60 ● ● ● ● ● 

VESA 2560 x 1080 @ 60Hz [RB1] 31 2560 1080 2720 1111 60 ● ● ● ● ● 

VESA 2560 x 1600 @ 60Hz 32 2560 1600 3504 1658 60 ● ● ● ● ● 

VESA 2560 x 1600 @ 60Hz [RB1] 33 2560 1600 2720 1646 60 ● ● ● ● ● 

Other 2880 x 1440 @ 60Hz 34 2880 1440 2976 1456 60 ● ● ● ● ● 

VESA 4096 x 2160 @ 60Hz 35 4096 2160 4176 2222 60 ● ● ●   

VESA 3840 x 2160 @ 30Hz [RB1] 36 3840 2160 4000 2191 30 ● ● ● ● ● 

VESA 3840 x 2160 @ 30Hz [RB2] 37 3840 2160 3920 2191 30 ● ● ● ● ● 

CTA 3840 x 2160 @ 30Hz 38 3840 2160 4400 2250 30 ● ● ● ● ● 

CTA 3840 x 2160 @ 50Hz 39 3840 2160 5280 2250 50 ● ●    

CTA 4096 x 2160 @ 50Hz 40 4096 2160 5280 2250 50 ● ●    

VESA 3840 x 2160 @ 60Hz [RB1] 41 3840 2160 4000 2222 60 ● ● ●   

VESA 3840 x 2160 @ 60Hz [RB2] 42 3840 2160 3920 2222 60 ● ● ●   

CTA 3840 x 2160 @ 60Hz 43 3840 2160 4400 2250 60 ● ●    

CTA 4096 x 2160 @ 60Hz 44 4096 2160 4400 2250 60 ● ●    
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DisplayPort Sink and Source Capability (YCbCr) 

Description TSI* 
H 

active 
V 

active 
H 

total 
V 

total 
Frame 

rate 

YCbCr 4:2:0 (bpc) YCbCr 4:2:2 (bpc) 

8  10   12   16  8   10   12   16   

VESA 640 x 480 @ 60Hz 0 640 480 800 525 60 ● ● ● ● ● ● ● ● 

VESA 800 x 600 @ 60Hz 1 800 600 1056 628 60 ● ● ● ● ● ● ● ● 

VESA 848 x 480 @ 60Hz 2 848 480 1088 517 60 ● ● ● ● ● ● ● ● 

VESA 1024 x 768 @ 60Hz 3 1024 768 1344 806 60 ● ● ● ● ● ● ● ● 

CTA 1280 x 720 @ 60Hz 4 1280 720 1650 750 60 ● ● ● ● ● ● ● ● 

VESA 1280 x 768 @ 60Hz 5 1280 768 1664 798 60 ● ● ● ● ● ● ● ● 

VESA 1280 x 960 @ 60Hz 6 1280 960 1800 1000 60 ● ● ● ● ● ● ● ● 

VESA 1280 x 800 @ 60Hz [RB1] 7 1280 800 1440 823 60 ● ● ● ● ● ● ● ● 

VESA 1280 x 800 @ 60Hz 8 1280 800 1680 831 60 ● ● ● ● ● ● ● ● 

VESA 1280 x 768 @ 60Hz 9 1280 768 1440 790 60 ● ● ● ● ● ● ● ● 

VESA 1280 x 1024 @ 60Hz 10 1280 1024 1688 1066 60 ● ● ● ● ● ● ● ● 

VESA 1360 x 768 @ 60Hz 11 1360 768 1792 795 60 ● ● ● ● ● ● ● ● 

VESA 1400 x 1050 @ 60Hz 12 1400 1050 1560 1080 60 ● ● ● ● ● ● ● ● 

VESA 1600 x 1200 @ 60Hz [RB1] 13 1600 1200 1760 1235 60 ● ● ● ● ● ● ● ● 

VESA 1600 x 1200 @ 60Hz 14 1600 1200 2160 1250 60 ● ● ● ● ● ● ● ● 

VESA 1680 x 1050 @ 60Hz 15 1680 1050 2240 1089 60 ● ● ● ● ● ● ● ● 

VESA 1680 x 1050 @ 60Hz [RB1] 16 1680 1050 1840 1080 60 ● ● ● ● ● ● ● ● 

VESA 1792 x 1344 @ 60Hz 17 1792 1344 2448 1394 60 ● ● ● ● ● ● ● ● 

VESA 1920 x 1080 @ 30Hz [RB1] 18 1920 1080 2080 1096 30 ● ● ● ● ● ● ● ● 

VESA 1920 x 1080 @ 30Hz [RB2] 19 1920 1080 2000 1096 30 ● ● ● ● ● ● ● ● 

CTA 1920 x 1080 @ 30Hz 20 1920 1080 2200 1125 30 ● ● ● ● ● ● ● ● 

VESA 1920 x 1080 @ 60Hz [RB1] 21 1920 1080 2080 1111 60 ● ● ● ● ● ● ● ● 

VESA 1920 x 1080 @ 60Hz [RB2] 22 1920 1080 2000 1111 60 ● ● ● ● ● ● ● ● 

CTA 1920 x 1080 @ 60Hz 23 1920 1080 2200 1125 60 ● ● ● ● ● ● ● ● 

VESA 1920 x 1080 @ 120Hz [RB1] 24 1920 1080 2080 1144 120 ● ● ● ● ● ● ● ● 

VESA 1920 x 1080 @ 120Hz [RB2] 25 1920 1080 2000 1144 120 ● ● ● ● ● ● ● ● 

CTA 1920 x 1080 @ 120Hz 26 1920 1080 2200 1125 120 ● ● ● ● ● ● ● ● 

VESA 1920 x 1440 @ 60Hz 27 1920 1440 2600 1500 60 ● ● ● ● ● ● ● ● 

VESA 2048 x 1536 @ 60Hz 28 2048 1536 2208 1580 60 ● ● ● ● ● ● ● ● 

VESA 2560 x 1440 @ 60Hz 29 2560 1440 2720 1481 60 ● ● ● ● ● ● ● ● 

VESA 2560 x 1080 @ 60Hz 30 2560 1080 3424 1120 60 ● ● ● ● ● ● ● ● 

VESA 2560 x 1080 @ 60Hz [RB1] 31 2560 1080 2720 1111 60 ● ● ● ● ● ● ● ● 

VESA 2560 x 1600 @ 60Hz 32 2560 1600 3504 1658 60 ● ● ● ● ● ● ● ● 

VESA 2560 x 1600 @ 60Hz [RB1] 33 2560 1600 2720 1646 60 ● ● ● ● ● ● ● ● 

Other 2880 x 1440 @ 60Hz 34 2880 1440 2976 1456 60 ● ● ● ● ● ● ● ● 

VESA 4096 x 2160 @ 60Hz 35 4096 2160 4176 2222 60 ● ● ● ● ● ● ●  

VESA 3840 x 2160 @ 30Hz [RB1] 36 3840 2160 4000 2191 30 ● ● ● ● ● ● ● ● 

VESA 3840 x 2160 @ 30Hz [RB2] 37 3840 2160 3920 2191 30 ● ● ● ● ● ● ● ● 

CTA 3840 x 2160 @ 30Hz 38 3840 2160 4400 2250 30 ● ● ● ● ● ● ● ● 

CTA 3840 x 2160 @ 50Hz 39 3840 2160 5280 2250 50 ● ● ● ● ● ● ●  

CTA 4096 x 2160 @ 50Hz 40 4096 2160 5280 2250 50 ● ● ● ● ● ● ●  

VESA 3840 x 2160 @ 60Hz [RB1] 41 3840 2160 4000 2222 60 ● ● ● ● ● ● ● ● 

VESA 3840 x 2160 @ 60Hz [RB2] 42 3840 2160 3920 2222 60 ● ● ● ● ● ● ● ● 

CTA 3840 x 2160 @ 60Hz 43 3840 2160 4400 2250 60 ● ● ● ● ● ● ●  

CTA 4096 x 2160 @ 60Hz 44 4096 2160 4400 2250 60 ● ● ● ● ● ● ●  
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HDMI Sink and Source Capability (RGB and YCbCr) 

Description TSI* 
H 

active 
V 

active 
H total V total 

Frame 
rate 

YcbCr 4:2:0 (bpc) YCbCr 
4:2:2 

4:4:4 (bpc) 

8  10   12   16  8   10   12   16   

VESA 640 x 480 @ 60Hz 0 640 480 800 525 60 ● ● ● ● ● ● ● ● ● 

VESA 800 x 600 @ 60Hz 1 800 600 1056 628 60 ● ● ● ● ● ● ● ● ● 

VESA 848 x 480 @ 60Hz 2 848 480 1088 517 60 ● ● ● ● ● ● ● ● ● 

VESA 1024 x 768 @ 60Hz 3 1024 768 1344 806 60 ● ● ● ● ● ● ● ● ● 

CTA 1280 x 720 @ 60Hz 4 1280 720 1650 750 60 ● ● ● ● ● ● ● ● ● 

VESA 1280 x 768 @ 60Hz 5 1280 768 1664 798 60 ● ● ● ● ● ● ● ● ● 

VESA 1280 x 960 @ 60Hz 6 1280 960 1800 1000 60 ● ● ● ● ● ● ● ● ● 

VESA 1280 x 800 @ 60Hz [RB1] 7 1280 800 1440 823 60 ● ● ● ● ● ● ● ● ● 

VESA 1280 x 800 @ 60Hz 8 1280 800 1680 831 60 ● ● ● ● ● ● ● ● ● 

VESA 1280 x 768 @ 60Hz 9 1280 768 1440 790 60 ● ● ● ● ● ● ● ● ● 

VESA 1280 x 1024 @ 60Hz 10 1280 1024 1688 1066 60 ● ● ● ● ● ● ● ● ● 

VESA 1360 x 768 @ 60Hz 11 1360 768 1792 795 60 ● ● ● ● ● ● ● ● ● 

VESA 1400 x 1050 @ 60Hz 12 1400 1050 1560 1080 60 ● ● ● ● ● ● ● ● ● 

VESA 1600 x 1200 @ 60Hz [RB1] 13 1600 1200 1760 1235 60 ● ● ● ● ● ● ● ● ● 

VESA 1600 x 1200 @ 60Hz 14 1600 1200 2160 1250 60 ● ● ● ● ● ● ● ● ● 

VESA 1680 x 1050 @ 60Hz 15 1680 1050 2240 1089 60 ● ● ● ● ● ● ● ● ● 

VESA 1680 x 1050 @ 60Hz [RB1] 16 1680 1050 1840 1080 60 ● ● ● ● ● ● ● ● ● 

VESA 1792 x 1344 @ 60Hz 17 1792 1344 2448 1394 60 ● ● ● ● ● ● ● ● ■ 

VESA 1920 x 1080 @ 30Hz [RB1] 18 1920 1080 2080 1096 30 ● ● ● ● ● ● ● ● ● 

VESA 1920 x 1080 @ 30Hz [RB2] 19 1920 1080 2000 1096 30 ● ● ● ● ● ● ● ● ● 

CTA 1920 x 1080 @ 30Hz 20 1920 1080 2200 1125 30 ● ● ● ● ● ● ● ● ● 

VESA 1920 x 1080 @ 60Hz [RB1] 21 1920 1080 2080 1111 60 ● ● ● ● ● ● ● ● ● 

VESA 1920 x 1080 @ 60Hz [RB2] 22 1920 1080 2000 1111 60 ● ● ● ● ● ● ● ● ● 

CTA 1920 x 1080 @ 60Hz 23 1920 1080 2200 1125 60 ● ● ● ● ● ● ● ● ● 

VESA 1920 x 1080 @ 120Hz [RB1] 24 1920 1080 2080 1144 120 ● ● ● ● ● ● ■ ■ ■ 

VESA 1920 x 1080 @ 120Hz [RB2] 25 1920 1080 2000 1144 120 ● ● ● ● ● ● ■ ■ ■ 

CTA 1920 x 1080 @ 120Hz 26 1920 1080 2200 1125 120 ● ● ● ● ● ● ■ ■ ■ 

VESA 1920 x 1440 @ 60Hz 27 1920 1440 2600 1500 60 ● ● ● ● ● ● ● ■ ■ 

VESA 2048 x 1536 @ 60Hz 28 2048 1536 2208 1580 60 ● ● ● ● ● ● ● ● ■ 

VESA 2560 x 1440 @ 60Hz 29 2560 1440 2720 1481 60 ● ● ● ● ● ● ● ■ ■ 

VESA 2560 x 1080 @ 60Hz 30 2560 1080 3424 1120 60 ● ● ● ● ● ● ● ■ ■ 

VESA 2560 x 1080 @ 60Hz [RB1] 31 2560 1080 2720 1111 60 ● ● ● ● ● ● ● ● ■ 

VESA 2560 x 1600 @ 60Hz 32 2560 1600 3504 1658 60 ● ● ● ■ ■ ■ ■ ■  

VESA 2560 x 1600 @ 60Hz [RB1] 33 2560 1600 2720 1646 60 ● ● ● ● ● ● ● ■ ■ 

Other 2880 x 1440 @ 60Hz 34 2880 1440 2976 1456 60 ● ● ● ● ● ● ● ■ ■ 

VESA 4096 x 2160 @ 60Hz 35 4096 2160 4176 2222 60 ● ■ ■ ■ ■ ■    

VESA 3840 x 2160 @ 30Hz [RB1] 36 3840 2160 4000 2191 30 ● ● ● ● ● ● ● ■ ■ 

VESA 3840 x 2160 @ 30Hz [RB2] 37 3840 2160 3920 2191 30 ● ● ● ● ● ● ● ■ ■ 

CTA 3840 x 2160 @ 30Hz 38 3840 2160 4400 2250 30 ● ● ● ● ● ● ■ ■ ■ 

CTA 3840 x 2160 @ 50Hz 39 3840 2160 5280 2250 50 ● ■ ■ ■ ■ ■    

CTA 4096 x 2160 @ 50Hz 40 4096 2160 5280 2250 50 ● ■ ■ ■ ■ ■    

VESA 3840 x 2160 @ 60Hz [RB1] 41 3840 2160 4000 2222 60 ● ● ■ ■ ■ ■    

VESA 3840 x 2160 @ 60Hz [RB2] 42 3840 2160 3920 2222 60 ● ● ■ ■ ■ ■    

CTA 3840 x 2160 @ 60Hz 43 3840 2160 4400 2250 60 ● ■ ■ ■ ■ ■    

CTA 4096 x 2160 @ 60Hz 44 4096 2160 4400 2250 60 ● ■ ■ ■ ■ ■    

Supported video mode and color depth (● HDMI 1.4a, ■ HDMI 2.0) 

*) TSI Timing ID 
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APPENDIX D: PREDEFINED PATTERNS 

Selection TSI * Pattern Description 

Disabled  N/A The links are activated but no video data transferred 

Color Bar 0 

 

100% intensity color bars of all primaries and mixed combinations. 

Chessboard 1 

 

8 by 8 chessboard with black (0%) and 100% intensity white 

Solid Black 2 

 

0% luminance 

Solid White 3 

 

100% white 

Solid Red 4 

 

100% red 

Solid Green 5 

 

100% green 

Solid Blue 6 

 

100% blue 

White Vertical 
Stripes 

7 

 

Vertical stripes of black (0%) and white (100%).  

Parameters set the widths of the black and white stripes in pixels respectively. 
Default black / white = 20 / 20 pixels. Parameter range 0 to 5000. 

Gradient 
Vertical Stripes 

8 

 

16 pixels high horizontal red green, blue and white stripes. 

Intensity is increased from 0 to 100% with steps defined by the given parameter 
(n). (step = n*color_depth/256). “n” range 0 to 5000 (default 120). 

Color Ramp 9 

 

Color Ramp test pattern defined by VESA DisplayPort Link Layer Compliance 
Test Specification. 

Color Square 10 

 

Color Square test pattern defined by VESA DisplayPort Link Layer Compliance 
Test Specification. 

Color mode can be selected between RGB, YCbCr 4:4:4, 4:2:2, 4:2:0 (ITU Rec 
601 / 709) 

White Square  

 

100% intensity white square horizontally and vertically centered. Height and width 
defined by parameter as the percentage of height and width of the frame (default 
30). 

Motion Pattern 11 

 

Horizontally moving color bar pattern. The pattern is shifted to left one pixel in 
each frame in a sequence. The length of the sequence is defined with parameter. 
Range 0 to 34 (default is 20) 

Custom Image  

 

Bitmap image uploaded by the user. Click on the Custom Images panel to 
browse.  

*) TSI Pattern ID 

More test patterns can be downloaded e.g., from https://sid.org/Publications/ICDM.aspx#7327477-test-patterns 
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APPENDIX E: SINK AND SOURCE DUT TESTS 

The tables below list the Unigraf TSI SDK Test Cases that you can run in Sink DUT Testing / Source DUT 

Testing tabs of UCD Console, their definition in TSI Reference Manual and the licensing needed. 

Source DUT Testing 

 

P
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Electrical Test Set (UCD-301) 
HDMI RX 

    

 Power test (TSI_TEST_HDMI_EL_POWER_LINE)   ✓ 

 TMDS test (TSI_TEST_HDMI_EL_TMDS_LINES)   ✓ 

 HPD test (TSI_TEST_HDMI_EL_HPD_LINE)   ✓ 

 DDC and CEC test (TSI_TEST_HDMI_EL_DDC_CEC_LINES)   ✓ 

Electrical Test Set (UCD-301) 
DP RX  

    

 HPD test (TSI_TEST_DP_EL_HPD_LINE)   ✓ 

 Main Link test (TSI_TEST_DP_EL_MAIN_LINK)   ✓ 

 AUX test (TSI_TEST_DP_EL_AUX_LINE)   ✓ 

CEC functional Test Set 
HDMI RX 

    

 CEC functional test (TSI_TEST_HDMI_CEC) ✓   

CRC based Video Test Set     

 
CRC based single frame reference video test 
(TSI_TEST_VIDEO_CRC_SINGLE_REF) 

✓   

 
CRC based single frame stability test 
(TSI_TEST_CRC_VIDEO_STABILITY) 

✓   

 
CRC based sequence of frames reference video test 
(TSI_TEST_CRC_VIDEO_SEQUENCE) 

✓   

Link Test Set 
DP RX 

    

 
Link Training at All Supported Lane Counts and Link Rates 
(TSI_TEST_DP_SIMPLE_LINK) 

✓   

HDCP 2.3 CTS 1A Test Set 
DP RX 

HCDP2.3 CTS 1A-01 – HCDP2.3 CTS 1A-13  ✓  

HDCP 2.3 CTS 1B Test Set 
DP RX 

HCDP2.3 CTS 1B-01 – HCDP2.3 CTS 1B-10  ✓  

 

Sink DUT Testing 

 

D
P

 H
D

C
P

 2
.3

 C
T

S
* 

HDCP 2.3 CTS 2C Test Set 
DP TX 

  

 HCDP2.3 CTS 2C-01 – HCDP2.3 CTS 2C-06 ✓ 
 

*) Separate licenses for testing Sink and Source DUT 
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Electrical Test Set – HDMI Rx 
Electrical Tests verify the continuity of the interface signals and the voltage levels applied by 

the driving electronics. 

Power Test 
Power Test verifies the voltage level on the +5 V power line (Pin 18) of the DUT source. The 

accepted value in HDMI specification is 4.7 V to 5.3 V on the sink side connector. (Called 

“TP2” in the HDMI specification). 

The test will measure the power line voltage using two loads: 0 mA and 55 mA. The latter is 

the test setup in HDMI CTS specification (HDMI CTS 1.4b: Test ID 7-11: +5V Power). The 

test will fail if voltage level on the power line is below or above the voltage range set by the 

parameters. 

Parameters in use 

▪ Test Timeout (default 5 000 ms) 

▪ Power line low voltage limit (default 4 700 mV) 

▪ Power line high voltage limit (default 5 300 mV) 

TMDS Test 
TMDS Test verifies average voltage levels on TMDS signal lines (8 lines: CLK+/-, D0+/- 

D1+/- and D2+/-). The positive and negative lines of the TMDS differential pair are measured 

separately. 

TMDS uses DC balanced signaling. Sink pulls the lines up to 3.3 V (AVcc) and source applies 

the TMDS signal by pulling the line down to ground. On an active TMDS line average voltage 

level is half of the voltage swing below AVcc (AVcc – Vswing/2). By default, 2.6 V to 3.1 V.  

TMDS line voltages outside of the above range might indicate an abnormal situation like short 

circuit of two TMDS lines, short to ground, open circuit or a broken output driver.  

If the measured values fall outside the criteria set by the parameters, test result is FAIL. 

Note:  Fail criteria for each test set-up should be considered separately depending on the 

source DUT and test cable configuration. 

Parameters in use 

▪ Test Timeout (default 5 000 ms) 

▪ Main link low voltage limit (default 2 600 mV) 

▪ Main link high voltage limit (default 3 100 mV) 

HPD Test 
HPD Test verifies HPD line (pin 19) for short circuits to power or ground. 

The test runs in two steps: 

Step 1. HPD line is driven to logical low state and after a delay voltage level is measured. If the 

measured value is outside the limits set by the parameters for “zero” voltage minimum and 

maximum the test result is FAIL. The judgement is “Short to ground” or “Short to power” 

depending if the measured value is below the allowed window, or above it. 

Step 2. HPD line is driven to logical high state and after a delay voltage level is measured. If 

the measured value is outside the limits set by the parameters for “one” voltage minimum and 

maximum the test result is FAIL. The judgement is “Short to ground” or “Short to power” 

depending if the measured value is below the allowed window, or above it. 
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Parameters in use 

▪ Test Timeout (default 5 000 ms) 

▪ HPD line logical zero low voltage limit (default -50 mV) 

▪ HPD line logical zero high voltage limit (default 400 mV) 

▪ HPD line logical one low voltage limit (default 2 400 mV) 

▪ HPD line logical one high voltage limit (default 5 300 mV) 

DDC and CEC Test 
DDC and CEC Test verifies voltage level of SCL (pin 15), SDA (pin 16) and CEC (pin 13) 

lines. HPD signal is driven low to de-activate any transmission in the tested lines. After a delay 

of 100 ms voltage level is measured in the three signal lines. 

If the measured voltage levels are outside the limits set by the parameters, the test result is 

FAIL. 

▪ Test Timeout (default 5 000 ms) 

▪ DDC lines low voltage limit (default 4 500 mV) 

▪ DDC lines high voltage limit (default 5 500 mV) 

▪ CEC line logical zero low voltage limit (default -50 mV) 

▪ CEC line logical zero high voltage limit (default 600 mV) 

▪ CEC line logical one low voltage limit (default 2 500 mV) 

▪ CEC line logical one low voltage limit (default 3 600 mV) 
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Electrical Test Set – DP Rx 
Electrical Tests verify the continuity of the interface signals and the voltage levels applied by 

the driving electronics. 

HPD Test 
HPD Test verifies HPD line for short circuits to power or ground. 

The test runs in two steps: 

Step 1. HPD line is asserted to logical high state and after a delay voltage level is measured. If 

the measured value is outside the limits set by the parameters for “one” voltage minimum and 

maximum the test result is FAIL. The judgement is “Short to ground” or “Short to power” 

depending if the measured value is below the allowed window, or above it. 

Step 2. HPD line is de-asserted to logical low state and after a delay voltage level is measured. 

If the measured value is outside the limits set by the parameters for “zero” voltage minimum 

and maximum the test result is FAIL. The judgement is “Short to ground” or “Short to power” 

depending if the measured value is below the allowed window, or above it. 

Parameters in use 

▪ Test Timeout (default 5 000 ms) 

▪ HPD line logical zero low voltage limit (default -100 mV) 

▪ HPD line logical zero high voltage limit (default 799 mV) 

▪ HPD line logical one low voltage limit (default 2 000 mV) 

▪ HPD line logical one high voltage limit (default 3 600 mV) 

 

Main Link Test 
The test utilizes a dedicated microchip to determine the power of DP Main Link input signal. 

The test verifies that the measured values lies within the window defined by provided 

parameters. 

The measured values provide a relative voltage value that depends on the signal waveform and 

selected pre-emphasis and voltage swing. The values do not represent any absolute value, e.g. 

input signal voltage level. 

“No signal” level is initially set to 2.3V. Note that even a disconnected line will give a 

relatively high value. Good signal levels are expected to be within range 2.6 V to 4.0 V. The 

allowed voltage window should be set separately for each device model after testing of several 

units. 

Measured values are expected to be close to each other within a differential pair. Also, all main 

link differential pair measurements should produce a value close to each other if link training 

result is the same for all pairs. 

Measurement results are given in volt, but this is only the voltage level of power measurement 

circuitry output and does not relate to the actual input signal. The positive and negative lines of 

main link differential pairs are measured separately. 

Note The measured values provide a relative voltage value that depends on the signal 

waveform and selected pre-emphasis and voltage swing. The values do not represent 

any absolute value, e.g. input signal voltage level. 
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Parameters in use 

▪ Test Timeout (default 5 000 ms) 

▪ Main link low voltage limit (default 2 600 mV) 

▪ Main link high voltage limit (default 4 000 mV) 

▪ Maximum lanes count supported by DUT (default 0) 

▪ Maximum data rate supported by DUT in 0.27 Gbps (default 0) 

AUX Test 
The test verifies voltage levels on AUX lines, and AUX connectivity to DUT. 

The test verifies two issues: 

1. The idle AUX voltage level is measured and compared to provided parameters. The voltages 

are expected to match values defined by resistor dividers set by connected DisplayPort sink 

and source devices. 

2. The TE creates a short HPD pulse to have the DUT to generate an AUX request. The DUT is 

expected to read DPCD register address range 0x200 – 0x205. Test captures the sync sequence 

of the AUX transaction and verifies the unit interval timings. 

The test is first done to AUX- line and then to AUX+ line. 

Parameters in use 

▪ Test Timeout (default 5 000 ms) 

▪ AUX+ line idle low voltage limit (default 2 400 mV) 

▪ AUX+ line idle high voltage limit (default 3 600 mV) 

▪ AUX– line idle low voltage limit (default 2 400 mV) 

▪ AUX– line idle high voltage limit (default 3 600 mV) 

▪ AUX+ line signal trigger low level (default 150 mV) 

▪ AUX+ line signal trigger high level (default 200 mV) 

▪ AUX– line signal trigger low level (default 200 mV) 

▪ AUX– line signal trigger high level (default 5 mV) 

▪ AUX signal capture timeout (default 4 ms) 

▪ AUX signal capture attempts (default 20 times) 
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CEC Functional Test Set – HDMI Rx 

CEC Functional Test 
TE verifies that source DUT correctly handles an HPD event, reads the sink EDID and 

broadcasts a CEC “Report physical address” message. 

First, the TE allocates the physical address provided as a parameter and issues an HPD pulse 

simulating cable detach/attach. After that the TE waits for DUT to broadcast the CEC “Report 

physical address” message. 

The test is considered passed if DUT sends a correct “Report physical address” message. 

Note: The default physical address in UCD-300 EDID is 1:0:0:0. In order to simulate a 

change in the address, please use another address range 

 

Note: As a side effect, the CEC will also verify functionality of HPD and EDID reading if the 

test passes. 

Parameters in use 

▪ Test Timeout (default 5 000 ms) 

▪ Local CEC physical address (default 4.0.0.0) 
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CRC Based Video Test Set – HDMI & DP Rx 

CRC Based Single Reference Frame Video Test 
The test compares captured frames to a provided reference. 

TE compares the video mode (Frame Width, Height, BPP and optionally Frame rate) to 

provided parameters and after that captures frames and compares the CRC (check sum) of their 

three color components to the provided reference until the number of bad frame limit provided 

is detected or the provided total number of frames is reached.  

The test is judged FAIL if video mode does not match or the number of bad frames is 

exceeded. 

The test optionally captures the failed frames as bitmap images and stores them into the hard 

disc. 

Parameters in use 

▪ Test Timeout (default 100 000 ms) 

▪ Total number of frames (default 2 000 ms) 

▪ Number of bad frames allowed (default 2) 

▪ Reference width (default 1920) 

▪ Reference height (default 1080) 

▪ Reference BPP (default 24) 

▪ Expected frame rate (mHz) 

▪ Frame rate tolerance (mHz) 

▪ Reference CRCs (R, G, B) 

CRC Based Single Frame Video Stability Test 
The test verifies that the captured video is stable. 

TE captures a frame and sets the CRC of its color components as reference. After that TE 

captures frames and compares their CRC (check sum) to the reference until the number of bad 

frame limit provided is detected or the provided total number of frames is reached.  

The test is judged FAIL if the number of bad frames is exceeded. 

The test optionally captures the failed frames as bitmap images and stores them into the hard 

disc. 

Parameters in use 

▪ Test Timeout (default 100 000 ms) 

▪ Total number of frames (default 2 000 ms) 

▪ Number of bad frames allowed (default 2) 
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CRC Based Sequence of Reference Frames Test 
The verifies that a sequence of frames is captured in the right order. 

TE compares the video mode (frame Width, Height, BPP and optionally Frame rate) to 

provided parameters. After that captures frames to find a frame with matching CRC (check 

sum) of their three color components to the first provided reference. After the first matching 

CRC is found it compares the CRC of the following frames until the Number of frames tested 

parameter is reached.  

The test is judged FAIL if video mode does not match, the first frame in the list is not found or 

the CRC of the following frames do not match the provided list. 

The test optionally captures the failed frames as bitmap images and stores them into the hard 

disc. 

Parameters in use 

▪ Test Timeout (default 100 000 ms) 

▪ Number of frames to be tested (default 20) 

▪ Reference width (default 1920) 

▪ Reference height (default 1080) 

▪ Reference BPP (default 24) 

▪ Expected frame rate (mHz) 

▪ Frame rate tolerance (mHz) 

▪ Reference CRCs (R, G, B) 

Note: Please note that in order for the TE to maintain the sequence, all CRCs in the reference 

frame list should be different. 
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CRC Based Continuous Sequence of Reference Frames Test 
The verifies that a sequence of frames is captured in the right order many times repeatedly. 

TE compares the video mode (frame Width, Height, BPP and optionally Frame rate and Color 

format) to provided parameters. After that captures frames to find a frame with matching CRC 

(check sum) of their three color components to the first provided reference. After the first 

matching CRC is found it compares the CRC of the following frames until the Number of 

frames tested parameter is reached. After that it resets the list and starts from the first CRC. 

The list is repeated until timeout or until the provided number of repetitions is reached. 

The test is judged FAIL if video mode does not match, the first frame in the list is not found or 

the CRC of the following frames do not match the provided list. 

The test optionally captures the failed frames as bitmap images and stores them into the hard 

disc. 

Parameters in use 

▪ Test Timeout (default 100 000 ms) 

▪ Number of frames to be tested (default 20) 

▪ Number of iterations 

▪ Reference width (default 1920) 

▪ Reference height (default 1080) 

▪ Reference BPP (default 24) 

▪ Expected frame rate (mHz) 

▪ Frame rate tolerance (mHz) 

▪ Expected color format 

▪ Reference CRCs (R, G, B) 

Note: Please note that in order for the TE to maintain the sequence, all CRCs in the reference 

frame list should be different. 
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Link Test Set – DP Rx 

Link Training at All Supported Lane Counts and Link Rates 

Test requests link training on all supported lane counts and link rates. Each link training must 

be successfully completed in order to pass the test. 

Parameters in use 

▪ Test Timeout (default 5 000 ms) 

▪ Max lane count supported by DUT (default 4) 

▪ Max lane rate supported by DUT as multiple of 0.27 Gbps.  

(valid settings 6, 10 and 20; default 20) 

▪ Long HPD pulse duration (default 1 000 ms) 

▪ Link training start timeout (default 5 000 ms) 

▪ Delay between test cycles (default 3 000 ms) 

VRR Tests – HDMI Rx 
Static VRR Test 

Test verifies that DUT Source applies expected static VRR value. 

After configuring the parameters operator starts the test. Test waits until DUT Source starts 

VRR mode. When VRR mode is detected, test verifies that received timing matches the VRR 

Value parameter and the data in received EMP packets match the timing. 

Quick Media Switching (QMS) Test 

Verify that VRR is set correctly when frame rate is changing with a set time interval. For 

example, change VRR from 30 to 60 Hz with step 1 each 1 second. 

After configuring the parameters operator starts the test. Test waits until DUT Source starts 

VRR mode. When VRR mode is detected, test verifies that VRR is changed after each time 

interval set by VRR Time parameter, and the applied VRR change is as set in the parameter. 

Test also verifies that data in received EMP packets match with applied VRR. 

Dynamic Test 

Verify that VRR is set correctly when frame rate is changing with each frame. For example, 

change VRR from 60 to 120 Hz with step 1 each frame. 

After configuring the parameters operator starts the test. Test waits until DUT Source starts 

VRR mode. When VRR mode is detected, test verifies that VRR is changed between each 

frame. Test also verifies that data in received EMP packets match with applied VRR. 
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APPENDIX F: ADVANCED FILTERS 

This the description of the advanced methods for filtering transactions in DP AUX 

analyzer in Event Log. The following help text can be seen as well by clicking the Help 

button of the Edit Filter Rule dialog. 

Note Please note that Filters are a very powerful tool. They can however unintentionally hide 

valuable data from you. Please be careful when applying custom filters. 

A good practice is to start from an existing filter and gradually add new rules while 

testing their performance.  

 

Note  Filtering and selecting the columns for display do not affect the actual data acquisition. 

All transactions and their full data are always captured. 

Data pattern expressions 

A data-pattern expression is a string that describes how to determine if a data-block 

should be considered as "matched" or "unmatched". The syntax used with data-pattern 

expressions in Aux Channel Analyzer is described below 

The data-block must be covered completely by the data-pattern expression. If the data 

block is shorter, or longer than the expression, then the data block is determined as "not 

matched". The '*' wildcard can be used to allow data blocks of any size to match. 

Whitespaces and new-lines are ignored and are allowed anywhere; White spaces and 

new-lines can be used strategically to make the expression more readable. 

For example: "*!(10)??(10)" is the same as "* ! (10) ? ? (10)" 

Comment blocks: 

Comments must be written enclosed in curly-braces '{' and '}'. 

Wildcards 

Wildcards used are '*' and '?' 

? = Match any single data byte only. 

* = Match any number of any data bytes. (including the possibility of matching NO data 

bytes) 

For data matching, the byte value must be enclosed in braces '(' and ')'. Use prefixes '$' 

to indicate HEX value, '%' to indicate BIN. No prefix indicates DEC. 

Examples: 

* ($10) ($00) : Matches any data pattern that has the bytes $10, $00 at end of data. 

? ($10) ($00) : Matches 3-byte data pattern that has $10 as second byte and $00 as third 

byte. 

* ($10) * ($00) : Matches any data pattern that has $10 and ending to a $00 byte. 

* ($10) * ($00) * : Matches any data pattern that has $10 and $00 after it. 

($10) ? * ($20) * : Matches any data pattern that has $10 as first byte, followed by $20 

with at least one other byte in between. (i.e. will not match $10, $20) 

Use '!' to invert the match: 

!($00) = Match any data byte that isn't $00. 
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Use '?' within HEX or BIN value to ignore that bit in comparison: 

($??) = ? = Any data Byte. 

($?0) = Any data byte with bits 0-3 cleared. 

(%1???????) = Any data byte with bit 7 set. 

(%0??????1) = Any data byte with bit 7 cleared and bit 0 set. 

The '!' inversion can still be used: 

!(%??????00) = Matches any data byte ending to %10, %11, %01 but not %00. 

To match a single data byte with more than one value, separate the values with comma 

',': 

(0, 1, 100, 200, 254) : Matches a data byte whose value is 0, 1, 100, 200 or 254. 

Invert the value group match with '!'. Value wildcard '?' is also allowed. 

Example: 

!(1, 2, 3) : Match any data byte other than 1, 2 or 3. 

!($?f, $f?) : Don't match data bytes with bits 0-3 set to 1, or data bytes that have bits 7-4 

set. 
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